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« INTRODUCTION

1.1. System Overview

1.1.1. USBeamPro Model 2323

The Model 2323 USBeamPro system is a PC based optical beam profiling
system offering a unique combination of performance and ease of use. Highly
accurate measurements can be made on both pulsed and CW lasers, over a
wide range of wavelengths, beam diameters, and power/energy levels.
Sophisticated, yet simple, Microsoft Windows-based software allows these
results to be displayed, analyzed and/or archived in real time at video rates.

The USBeamPro Model 2323 includes the USB2.0 CMOS Camera and the
Acquisition and Analysis Software.

1.1.2. USBeamPro Acquisition and Analysis Software

The USBeamPro Software is written for Microsoft Windows XP Professional
(32-bit), Microsoft Windows Vista Business (32-bit) or Microsoft Windows
2000 Professional and takes full advantage of the menu driven, multi-
windowing environment.

Windows available for data display include:

¢ Video window Displays live video images;

¢ Dual Aperture Displays pinhole or slit profiles;
Profile window

¢ Beam Statistics Displays computed beam parameter
window values and statistics;

¢ 3D Profile View Displays 3-dimensional
windows representations of beam intensity;

¢ 2D Contour View Displays 2-dimensional contours of the
windows beam intensity;

Photon Inc. B051007616-1.07
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¢ Time Statistics Displays strip chart graphs of selected
windows (up to 15) beam parameters;
¢ Pointing window Displays a target screen for observing
beam pointing and divergence;
¢ K-Factor (M?) An interactive K-Factor Wizard
window program for measuring K-factor (M?)
by the Rayleigh Method;
¢ Notes window A simple text editor for entering user
annotations;

The software also performs rigorous data analysis over specific regions-of-
interest (ROIs) in accordance with the ISO standards. The ROIs can be
either system or user defined. Quantitative measurement of numerous beam
spatial characteristics is possible. Pass/Fail limit analysis for each of these
parameters can be also applied.

Parameters measured include:

Beam width

Centroid and peak location

Major and minor axes

Beam orientation

Ellipticity, eccentricity

Gaussian fit

Beam uniformity

Beam divergence

Pointing stability

M2, K-factor

For data visualization, the user can arrange and size multiple windows as
required. These may contain, for example, live video, calculated beam
parameters and summary statistics in the form of graphs, tables, 3D views

and strip chart time displays. These user instrument views can be saved as
files for future use.

® & & & O O o o o

*

Data can be exported to spreadsheets, math and statistical analysis
programs and process/instrumentation control programs by logging to files
or COM ports, or by sharing using ActiveX Automation.

Live video of both pulsed and CW laser beams can be viewed in false color
or gray scale. False color options include rainbow and four monochrome
colors. This allows the user to choose a display color that can be seen
clearly while wearing laser goggles. Beam profiles through the centroid, the
peak or user defined points can be displayed. Profile orientation can be
either in the horizontal and vertical axes or along the major and minor axes
of elliptical beams.

B051007616-1.07 Photon Inc.



Chapter 1. Introduction 1.3

Hardware and software installation instructions, the features of the software,
operating hints and answers to frequently asked questions are presented in
this operating manual. In addition, you can refer to the extensive on-line
Help menu of the BeamPro Analysis Software program for this information.

Finally, to take full advantage of the features of the software, it is assumed
that users have a working knowledge of the Windows operating systems
and are familiar with basic Windows features such as opening, closing and
saving files, making menu selections, opening, arranging, and resizing
windows, etc. If these procedures are not familiar, see the Windows online
Help, accessed by clicking on the Start button and selecting Help, or refer
to numerous available Microsoft Windows manuals and tutorials.

1.2. Model 2323 Camera Specifications

¢ Interface: USB 2.0
¢ USB Connector: USB mini-B 5 pin
¢ USB Cable: USB mini-B 5 pin to USB A
¢ Sensor: 1.3 MegaPixel CMOS 2/3”
¢ Effective Pixel Elements: 1280 (H) x 1024 (V)
¢ Pixel Size: 6.7um x 6.7um
¢ Array Dimension: 8.6mm x 6.9mm
¢ Scanning Mode: Progressive
¢ A/D Conversion: 10 Bit
¢ Maximum Frame Rate: 27 frame per second
(full resolution)
Exposure range: 30 ps to 30 ms
¢ Trigger: Internal or External

(Software selectable)
¢ External Trigger Specifications: TTL (Positive transition)

¢ HIGH Level: 2to5VDC
¢ LOW Level: -0.3t0 0.8 VDC
¢ Trigger Connector: Hirose 6 pin
¢ Trigger Cable: Hirose 6 pin to BNC
. Dimensions, W x L x H: 54.2mm x 54.2mm x 32.6mm
¢ Lens Mount Type: C-mount
¢ Operating Temp: 0 to 50°C
¢ Supply Voltage: 4.40 to 5.25 V supplied by
USB 2.0 interface
¢  Supply Power: <1.6 W

Photon Inc. B051007616-1.07
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WARRANTY
INFORMATION

Photon’s products are covered by limited warranty on parts and labor for 12 months
from shipment date and 13 months if shipped to an authorized representative
except as noted below. This warranty covers parts and labor to repair the
equipment that fails to perform due to problems that are innate to the units and its
components, but not due to neglect or misuse. Photon cannot be held liable for any
damages beyond the original equipment cost.

Photon does not warrant incorrect use of instruments, such as but not limited to:
¢ Connecting or disconnecting a plug-in card with the computer powered on.

¢ Plugging your computer into a wall outlet without a surge protection strip.

Photon reserves the right to determine if the
problem has been caused by improper use.

Warranty is not transferable except through resale of products by authorized agents
of Photon inc. Unauthorized transfer of equipment and/or modifications to the
equipment are grounds for voiding warranty coverage.

Photon reserves the right to void the warranty if the Buyer fails to meet the terms of
purchase such as, but not limited to, a payment after the stated agreed invoice
payment date or failure to pay for shipping charges.

This is Photon’s sole warranty with respect to its products. No statement,
agreement or understanding, oral or written, made by an agent, distributor,
representative or employee of Photon, which is not contained in this warranty will
be binding upon Photon, unless made in writing and executed by an officer. Photon
makes no other warranty of any kind, whatsoever, expressed or implied. All implied
warranties of merchantability and fithess for particular use, which exceed the
aforementioned obligation, are hereby disclaimed by Photon and excluded from this
agreement. Under no circumstances shall Photon be liable to Buyer in contract or
in tort, for any special, indirect, incidental or consequential damages, expenses,
losses or delays however caused.

Photon must be notified of the defect or nonconformity within the warranty period
and the affected product returned to Photon’s factory or an authorized service
center within 30 days after the discovery of such defect or nonconformity. Shipment
to Photon shall be made with an RMA# and prior authorization by Photon. Warranty
repairs will be returned pre-paid lowest cost shipping method: for example, ground
shipment if within the USA. If a faster return is desired, the Buyer must pay the
shipping charges.

B051007616-1.07 Photon Inc.



2 - System Inspection

2.1. Inspection

If you did not inspect the shipping container prior to
unpacking, please do so now before going any further.
Your USBeamPro system has been carefully tested, inspected and packaged
prior to shipment. Photon performs extensive testing to ensure that the unit is in

proper working order. Upon receipt, please inspect your USBeamPro system for
the following:

¢ Note any damage to the shipping container. Please report any
damage found immediately to the shipping company. Photon
does not warrant damage that occurs as a result of shipment.

¢ Check the contents of your shipment against the packing slip
attached to the shipping box. Please note any discrepancy.

¢ A warranty form is included with all new units. Please complete
this form and return it to Photon to activate your warranty.

2.2. USBeamPro System Packing List

The following items are shipped as part of the 2323 USBeamPro Beam Profiling
System:

. Model 2323 2/3” USB 2.0 CMOS Camera

¢ USBeamPro Acquisition and Analysis Software CD for Microsoft
Windows XP Professional (32-bit), Microsoft Windows Vista
Business (32-bit) or Microsoft Windows 2000 Professional

USB A to USB mini-B cable
Hirose 6 pin to BNC external trigger cable
Operating Manual

Photon Inc. B051007616-1.07






3. SYSTEM SETUP

3.1. Personal Computer Requirements

To ensure the successful installation and operation of the USBeamPro
system, verify that your PC has the following minimal requirements:

¢

¢

® & & 6 O o o o

1.8GHz or faster Pentium IV Processor

Microsoft Windows Vista Business (32-bit edition), Microsoft
Windows XP Professional SP2 (32-bit edition) or Microsoft
Windows 2000 Professional SP4 Operating System

USB 2.0

512 MB of RAM

CD Drive

30MB free space on hard disk
SVGA Display Monitor

64MB Color SVGA Graphics Card
Mouse or other Pointing Device
Keyboard

3.2.  Setup for Microsoft Windows Vista Business
(32-bit edition)

In order to properly install and configure the camera and/or the software you
will need Administrator Rights. (Please contact your system administrator for
details regarding the Administrator Rights).

3.2.1. 2323 USBeamPro Camera

1.

Power up the computer and start Windows Vista Business;

Photon Inc.
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Connect the USB cable (USB mini-B end) to the camera;

Connect the USB cable (USB A end) to an available USB 2.0
port;

Microsoft Windows will automatically detect the camera and
the Found New Hardware message box will appear stating
that a Video device has been detected; After the Found New
Hardware Wizard starts select Locate and install driver
software (recommended). An User Account Control
dialog box will appear, asking permission to continue. Select
Continue to proceed with the driver installation;

If Found New Hardware wizard will ask permission to
search online for driver software for the new Video device.
Select Don’t Search Online;

Insert the USBeamPro CD into the CD drive; If the CD is
already in the Drive select Next to continue;

Windows will detect the USB2.0 SMX-I15x Series Sumix
Camera Drive and install the drivers;

A Window Security dialog box will display a message
stating that Windows cannot verify the publisher of the
software. Select Install this driver software anyway to
continue the driver installation;

The USBeamPro Camera driver installation is complete.
Click Close to finish the driver installation and exit the Found
New Hardware wizard.

3.2.2. USBeamPro Acquisition and Analysis Software

3.3.2.1. Installation

1.

3.

Insert the USBeamPro CD into the CD Drive. If the CD is
already in the drive or the Setup does not start automatically,
open Windows Explorer and browse to USBeamPro CD and
double click setup.exe.

If an User Account Control dialog box appears stating that an
unidentified program wants to access your computer, select
Allow (I trust this program. | know where it's from or I've used it
before.) to continue the software installation.

Follow the instructions and, if it is possible, accept the default -
(suggested) settings.

4. This completes the software installation and configuration.

B051007616-1.07
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Chapter 3. System Setup 3.3

3.3.2.2. Uninstallation

1.

Open the Control Panel by clicking Start and then Control
Panel.

Under Programs select Uninstall a Program.

Select USBeamPro from the software list, and then click the
Uninstall icon.

If Program and Features dialog box appears asking Are you
sure to uninstall USBeamPro click Yes.

If an User Account Control dialog box appears stating that an
unidentified program wants access to your computer, select
Allow to continue uninstalling the software.

Wait for uninstallation to finish.

3.3.  Setup for Microsoft Windows XP Professional
(32-bit edition)

In order to properly install and configure the camera and/or the software you
will need Administrator Rights. (Please contact your system administrator for
details regarding the Administrator Rights).

3.3.1. 2323 USBeamPro Camera

1. Power up the computer and start Windows XP;
2. Connect the USB cable (USB mini-B end) to the camera;
3. Connect the USB cable (USB A end) to an available USB 2.0

port;

The Found New Hardware message box will appear stating that
a Video device has been found; When the Found New
Hardware Wizard appears, select No, not at this time when
prompted to allow Windows to connect to Windows update to
search for software and click Next; in the next screen select
Install the software automatically (recommended) and click Next;

5. Insert the USBeamPro CD into the CD drive;
6. Windows will detect the USB2.0 SMX-115x Series Sumix

7.

Camera Drive and install the drivers; if a message pops-up
alerting that "The software you are installing for this hardware:
USB2.0 SMX-115x Series Sumix Camera Drive has not passed
Windows Logo testing to verify its compatibility with Windows
XP” click Continue Anyway.

Click Finish.

Photon Inc.
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3.3.2. USBeamPro Acquisition and Analysis Software
3.3.2.3. Installation
1. Insert the USBeamPro CD into the CD Drive. Open Windows
Explorer and browse to USBeamPro CD and double click
setup.exe.
2. Follow the instructions and, if it is possible, accept the default
(suggested) settings.
3. After the software is loaded, a dialog box will appear asking if
you want to restart the computer. Click Yes when prompted.
4. This completes the software installation and configuration.
3.3.2.4. Uninstallation
1. Open the Control Panel by clicking Start and then Control
Panel.
2. Double-click the Add / Remove Programs icon.
3. Select USBeamPro, then click the Remove button.
3.4.  Setup for Microsoft Windows 2000

Professional

In order to properly install and configure the camera and/or the software you
will need Administrator Rights. (Please contact your system administrator for
details regarding the Administrator Rights).

3.4.1.

2323 USBeamPro Camera

1. Power up the computer and start Windows 2000;
2. Connect the USB cable (USB mini-B end) to the camera;

3. Connect the USB cable (USB-A end) to an available USB 2.0
port;

4. The Found New Hardware dialog box will appear stating
that a multimedia video controller has been found;

5.  When the Found New Hardware Wizard appears click Next;
6. Insert the USBeamPro CD into the CD drive;

7. Select Search for a suitable driver for my device
(recommended) and click Next;

B051007616-1.07 Photon Inc.



Chapter 3. System Setup 3.5

3.4.2.

3.3.2.5.

3.3.2.6.

10.

Select CD-ROM drives and click Next to start searching for
the device driver;

Windows will detect the drivers on your CD. Click Next to
install the drivers;

Click Finish; then continue to the next step;

USBeamPro Acquisition and Analysis Software

Installation

1.

4.

Load the USBeamPro CD into the CD Drive. Open Windows
Explorer and browse to USBeamPro CD and double click
setup.exe.

Follow the instructions and, if it is possible, accept the default
(suggested) settings.

After the software is loaded, a dialog box will appear asking if
you want to restart the computer. Click Yes when prompted.

This completes the software installation and configuration.

Uninstallation

1.

Open the Control Panel by clicking Start then selecting
Settings and then Control Panel.

Double-click the Add / Remove Programs icon.
Select USBeamPro, then click the Remove button.

Photon Inc.
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4. ACQUISITION AND ANALYSIS
SOFTWARE

4.1. Quick Start

4.1.1. Starting the Program
To run the USBeamPro Acquisition and Analysis Software program:

From the Windows Start menu, select Programs, then Photon, and then
USBeamPro or select the USBeamPro icon from your desktop.

After installation when the program is first started, the Video window will
appear. At this point the program GUI can be configured as desired with the
multiple windows available. Alternatively, a sample startup GUI configuration
screen is available that can be opened from the File menu. The sample
configuration file name is “Example.usc” and can be found in the directory
where the software was installed, (default directory is “C:\Program
Files\Photon\USBeamPro”). There are 6 windows on this sample screen,
including:

Video window
Profile window

Beam Statistics window

3D Profile window

® & & oo o

Pointing window

¢ Notes window
Figure 4.1 shows the Example.fus configuration screen and the arrangement
of these 6 windows.

At first startup, the system will NOT be collecting data. (If the program does
not start, refer to the Troubleshooting section at the end of this manual.)

Photon Inc. B051007616-1.07



4.2 USBeamPro Installation and Operation Manual

USEeamPro - C:\Program Files\Photon\USBeamPro\Example. uso
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Figure 4.1. “Example.usc” Configuration Screen.

The software has 2 Acquisition Modes for image acquisition and
processing. These are accessed under the Data Collection menu or through
the icons from the main toolbar:

Laser Positioning: used for positioning the
laser beam in the sensor aperture as shown in
the Video window;

d:, Analysis: used to obtain Beam Parameters on

G
. %""’ a continuous basis;

At first startup, the system is in Laser Positioning Acquisition Mode.

The software has 3 Trigger Modes, accessed under the Data Collection
menu:

¢ CW for CW lasers;

¢ Pulsed for Pulsed lasers where an external sync trigger is
NOT available;

¢ External for Pulsed lasers where an external sync trigger is
available.

At first startup, the system is in CW Trigger Mode.

B051007616-1.07 Photon Inc.
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4.1.2. Position the Laser Beam in the Aperture.
To begin collecting data, select Global Data Collection from the Data

Collection menu, or alternatively, use the 4 icon on the toolbar, or depress
the Ctrl+G ‘Hot Key’. The Video window will now be displaying data. The
other windows will remain blank because data processing is inhibited in
Laser Positioning mode to provide the fastest video update.

Adjust the laser beam steering or the camera position until the beam image
is centered in the aperture as viewed in the Video window. The Video
window uses false color schemes to code the beam intensity. The default
scheme is the ‘rainbow’ spectrum, with low intensity toward the violet and
high intensity toward the red. White indicates a saturation condition. If the
beam is too intense and saturation is observed, attenuation will be needed.
To fully utilize the system dynamic range and achieve the specified accuracy
in beam measurements, adjust the laser intensity to a level just below the
saturation level.

4.1.3. Trigger Mode for Pulsed Lasers
If your laser is CW, skip this step.

To measure pulsed laser beams, use either the External Trigger Mode or the
Pulsed Trigger Mode. These trigger modes are discussed below. If you can
provide an external trigger, the best way to measure pulsed laser beams is
using the External Trigger Mode. External triggering requires a TTL signal,
with the trigger occurring on the positive-going (leading) edge. The external
trigger cable provided with the system connects to the camera with a Hirose
connector and has a BNC connector for the TTL signal input.

If you cannot provide an external trigger, use the Pulsed Trigger Mode.
When this mode is selected, the software will automatically determine the
presence of the beam based on minimum signal amplitude of 32 counts out
of 1024. In this mode, the update rate will, in general, be reduced from that
obtainable using the External Trigger Mode. The Trigger Mode can be
changed through the Data Collection menu using the mouse. Open the
Trigger Mode menu and select either Pulsed or External.

Trigger Mode

Pulsed
External

Photon Inc. B051007616-1.07
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4.1.4. Calibrate the System

It is necessary to perform a calibration prior to making beam measurements
to obtain the specified accuracy. To calibrate, select Calibration from the
Data Collection menu. The Camera Calibration dialog box will appear.

In the user interface, there are two visual indicators (the calibration icon on
the main toolbar and the message in the last pane of the Status Bar), which
changes depending on the system calibration status. The icons change to
indicate the status of calibration, as follows:

System Uncalibrated

System Settings Changed since last calibration

® @@

System Calibrated under current system settings

System settings include camera exposure, trigger mode, and unit serial
number.

If the last pane of the status bar displays the message “Calibration conditions
changed” or the calibration icon corresponds to the “System settings
changed” the system has been calibrated, but that something about the
measurement configuration has changed; either the exposure, the trigger
mode, or the unit serial number. In this case it is recommended to recalibrate.

To calibrate, use the displayed Calibrate icon, @ @ on the main

toolbar or select Calibration from the Data Collection menu. The Camera
Calibration dialog box will appear.

Camera Calibration @

|S_I,Istem calibrated om: 2/14/2006 3:56:16 Ph.

Fleaze block the lazer beam.
Prezs the Calibrate button.
Freszz OF, then release the beam.

x|
ol et |

Simply follow the directions. Block the beam (as far from the camera aperture
as possible) and click the Calibrate button. Then click on the OK button. This
completes the calibration procedure.

B051007616-1.07 Photon Inc.
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4.1.5. Switch to Analysis Mode

To start measuring Beam Parameters, the system must be set to Analysis
Mode. The Analysis Mode can be set by selecting Acquisition Mode from
the Data Collection menu and clicking on Analysis.

Acquisition Mode Laser Pasitioning
v Analysis

Alternatively, use the = icon on the toolbar. The Profile, Beam Statistics,

and 3D Profile windows will now display data and images.

4.1.6. Beam Parameters - Computation and Display

4.1.6.1. Computation of Parameters

Beam parameters are computed when the system is operating in the
Analysis Acquisition Mode. The computations that are performed are
determined by selections made in the Data Analysis dialog. To optimize the
data update rate, all computations are done on a subset of the entire video
image called the Beam Area. The number of pixels in the Beam Area that
are actually used in the calculations are determined by the Acquisition
Resolution. The computations also use the effective pixel dimensions and
the Magnification Factor.

4.1.6.2. Beam Area

If the system is set for Auto Track, the Beam Area is automatically
determined to include the entire laser beam image but to be of minimal size.
(This is to minimize the computation time by keeping the Beam Area as small
as possible.) If the system is not set for Auto Track, a Beam Area must be
set manually so that computations are performed. To set the Beam Area
manually, either use the Set Beam Area selection under the Video window
Options menu, or use the Set Beam Area drawing tool on the Video window
toolbar. The Beam Area-Position/Size dialog box can also be used to define
the top, left, width and height coordinates.

4.1.6.3. Acquisition Resolution

This item under the Data Collection menu is for selecting the resolution to
be used for computation and analysis of video image pixel data. This feature
is intended for large laser beams, where the rate of data analysis can be
increased by reducing the number of pixels used in the computations. The
choices are 1x and 1/2x. Selecting 1/2x will increase the rate of analysis.
When 1x is selected all the pixels in the video image pixel array are used for
computations. When 1/2x is selected, only 1/4 of the pixels (i.e. every other
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pixel in every other line in the camera array) are acquired and used for
computations. In this case the effective pixel linear dimension is twice (or 2x)
as large as the basic linear pixel dimension.

4.1.6.4. Magnification Factor

This item under the Data Collection menu opens a dialog box for entering
an optical magnification factor. This is necessary to obtain accurate beam
width values whenever optical components such as lenses or mirrors with
magnification are used to image a laser beam. This factor is used to scale
the linear pixel dimension of the camera selected for measurements. The
default magnification factor is 1. (If you do not know the magnification factor
of your optical system, it can be determined by mechanically translating an
object a known distance horizontally through the image. The measured
translation of the object in the image divided by the known mechanical
translation is the magnification factor.)

4.1.6.5. Displaying Parameters.

Computed parameters can be displayed in the Beam Statistics window or in
the Time Statistics windows. The selection of parameters for display is
accomplished through the Parameters entry under the Options menus for
these windows. Selecting the Parameters entry opens a dialog box for
specifying which parameters will be displayed.

4.2. Advanced Use

The previous Quick-Start procedure utilizes only the very basic features of
the USBeamPro Acquisition and Analysis Software program. The program is
very powerful and flexible, allowing users to configure the image data
acquisition, the analyses, and the information display windows to suit their
individual needs.

The Data Collection menu includes selections that determine or affect the
collection of data. Through the Data Analysis dialog, users select the types
of data analyses that will be performed, all in accordance with the ISO
Standards.

Numerous parameters can be computed and displayed, determined in the
Beam Statistics Parameters dialog. Parameters measured include:

¢ Beam width

Centroid and peak location
Major and minor axes
Beam orientation

Ellipticity, eccentricity

® & o o
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Gaussian fit
Beam uniformity
Beam divergence
Pointing stability
¢ M2 K-factor

Three methods for computing beam widths; Dsjit Denergy, O Das, are available
in either XY or Elliptical analysis modes.

® & o o

Energy/Power Uniformity or Flat Top analyses can be performed on
selected regions of interest.

There are also three methods of computing Beam Divergence.

Windows available for display include the:

¢ Video window;
. Profile window;
¢ 2D Contour window;
¢ 3D Profile window;
¢ Beam Statistics window;
¢ Time Statistics window;
¢ Pointing window;

¢ K-Factor window.
Each window has an Options menu that offers many choices in how data will
be displayed. There is also a Notes window for entering text. Users can
arrange and size multiple windows as required, and these screens can be
saved as files for future use. Limit Analyses can be performed on selected
beam parameters. Also, data can be exported to spreadsheets, math and

statistical analysis programs, and process/ instrumentation programs by
logging data to files or COM ports, or shared using ActiveX Automation.

A complete description of the various features of the program is given in this
section. Users are encouraged to learn the software features in detail and to
experiment with the program. A little time spent in advance learning the
features of the system will go a long way in making the USBeamPro
Acquisition and Analysis System an invaluable resource for laser beam
characterization.

4.3. Operating Hints
1.  Use the manual to completely familiarize yourself with all the

features of the USBeamPro Acquisition and Analysis
Software.
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Use Laser Positioning mode for positioning the laser beam
in the aperture, and also for course tuning of the laser beam.
Only use Analysis mode when you need parameter values.

Configure the Data Analysis and Beam Statistics
Parameters only for values that are needed. For example, do
not use Elliptical Analysis if the laser beam is nearly circular.
Additional computations require more time and reduce the
system performance in terms of data update rate and the
cross hairs will be very unstable, constantly jumping around to
find the “ellipse”.

Calibrate the system periodically. Array sensors are very
sensitive and can sense changes in background light intensity
due to such things as reflections from a white shirt or light
from a computer monitor. For accurate and repeatable
measurements, the consistency of the experimental setup is
important. Therefore, calibrate the system whenever there is
a change in setup or background lighting. This will ensure the
most consistent and accurate results.

Open only those windows that are required by vyour
application. Additional windows reduce the data update rate.
This is particularly true for the Video, 2D Contour, and
3D Profile windows. If all you need is beam width values, and
you require the fastest data update rate, close unnecessary
windows, including the Video window, and use only the Beam
Statistics and/or Time Statistics windows.

Every window has a display update rate that is configured
under the Options menu for each window. You may want to
change the default Timing settings in order to improve the
performance of your system.

Use Autotracking if your beam is stable. If your beam is
unstable, the Beam Area as defined by the Autotracking
algorithm will also be unstable. This will adversely affect the
Profile and 3D Profile windows, in that the displays will tend
to change or pop with each change in the Beam Area. In this
case, set a manual Beam Area to eliminate these effects.

Use Frame Background Subtraction, because the
USBeamPro CMOS chip has a shaded background. Frame
Background Subtraction will also eliminate any stray light
that is not due to the incident laser beam.

If data is being collected over long periods of time, use the
Automatic backup feature to prevent total loss of data in the
event of a Windows General Protection Fault.

B051007616-1.07
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4.4, Program Menus

4.4.1. File Menu

As in any other Windows compliant program, the File menu is used for file

manipulation and printing.

When File on the Menu Bar is clicked, the pull-down menu below appears.

New

Open...

Close

et ZErlHR
Cpen. .. Chrl+i0
Close

Save ChE+S
Save As...

Preferences »

Prink. .. CErHP
Prinkt Setup...

1 Sample.usd

Exxit

Closes all open windows, then creates a new
Video window.

Opens the File Open dialog box. It lists Data
Files from the current working directory.

To open a data file, select one from the list and
then select the Open button. All windows will be
closed and the new file will be loaded. The
data, windows and computed statistics from the
file will be displayed.

To open a configuration file, repeat the above
steps except select Configuration Files from
the Files of Type combo box. The list will show
all configuration files in the current working
directory. Configuration files contain everything
that a data file does, except for the raw data
and beam statistics. Use this to save a
particular screen layout and set of data
acquisition parameters without the raw and
computed data.

Closes all open windows and halts data
collection.

Photon Inc.
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Save Saves the current data and windows
configuration in the currently active file. The
name of this file is displayed on the main
window title bar.

Save As... Opens the File Save As dialog box. It lists Data
Files from the current working directory. Either
select an existing file from the list or enter a
new name in the File Name edit box. To save
as a data file, simply select the Save button.
There are 5 different file types, identified by
their extensions:

*.usd Data File: Includes screen configuration and
associated image and computed data. Only the
USBeamPro Acquisition and Analysis Software
can use this file.

*.USC Configuration File: Includes screen configuration
only. Only the USBeamPro Acquisition and
Analysis Software can use this file.

*prw Frame Data - Raw File: Includes raw image
data only. The Frame Data File is a binary file. It
contains the number of columns and rows,
saved as unsigned short (16-bit unsigned), then
each pixel of the frame as an unsigned char (8-
bit unsigned). This file cannot be read back by
USBeamPro Acquisition and Analysis Software.

* tif Frame Data - TIFF File. Saves the current
frame (raw image) as uncompressed 16-Bit
TIFF image.

*.asc ASCII File. Saves data displayed in all open

views in ASCII format.

IMAGE Saves the program screen as an IMAGE file,
either BMP, JPEG, GIF, TIFF, or PNG File.
This is used for exporting graphics into
documents and reports. The IMAGE file format
is selected under Image Settings dialog in the
File menu Preferences item.

Preferences TimedBacu..
On Power Up L4
On Exit 4

Image Settings...

B051007616-1.07 Photon Inc.
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Timed Backup

On Power Up

Load Previous
Setup

Global Collect
On

Background
Logo

On Exit

Save Setup

Prompt

Opens the Automatic Data Backup dialog
box. If the Backup On checkbox is selected,
then all data will be saved automatically at the
specified interval. Use this feature when
collecting data over extended periods to
prevent data loss in the event of a power
outage or other catastrophe. When the program
is restarted after such an event, the backup file
will load and data collection resumes from the
point of the last automatic save.

Automatic Data Backup g|

v Backup On
Backup Interval
10 ﬂ mirutes

(] Cancel

Opens a menu with the following 3 selections:

O Power Lp g Load Previous Setup
Global Collect On
Backaround Logo

When checked, the last data file will
automatically load at startup.

When checked, data collection resumes at
startup.

When checked, the Photon Logo appears as
the background for the main window.

Opens a menu with the following selections:

Save Setup
Prompk

When checked, the Save As dialog box
appears, prompting the user to save the latest
data.

When checked, the user is prompted with an
Leaving Already? dialog upon exit.

Photon Inc.
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Image Settings... Opens a dialog box for selecting the image
export format for the active window and the full
screen. Available choices for Image Format
are:

BMP Windows Bitmap
JPEG  JPEG File Interchange Format (JFIF)
GIF Graphics Interchange Format
TIFF Tagged Image File Format
PNG Portable Network Graphics
This dialog is also used to set the image
compression for JPEG Files.

Image Settings &l

Image Farmat |.JF'EI3 File Interchange Format ﬂ

JPEG Compression

J 100
Smaller File Larger Filz
[lovwer quality] [higher quiality]
Cancel
Print... Prints a picture of all open windows to the

currently selected default printer. The user may
change this printer from the Print dialog if
desired.

Print Setup... Opens a dialog box for selecting and
configuring printers

Exit Exits the program.

4.4.2. Edit Menu

When Edit on the Menu Bar is clicked, the pull-down menu below appears:

Copy Cirl+C
Export...
Copy Copies the current window to the Windows

clipboard as a bitmap image and/or text,

B051007616-1.07 Photon Inc.
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depending on the active view. From there, the
information can be pasted into other program
applications.

Export... Opens the File Save As dialog box for
exporting the active window as an image file,
either BMP, JPEG, GIF, TIFF or PNG, used for
exporting graphics into documents and reports.
The image file format is selected under Image
Settings dialog in the File menu, Preferences
item.

4.4.3. View Menu

When View on the Menu Bar is clicked, the pull-down menu below appears:

v Main Toolbar
v Local Toolbar
W Stakus Bar

Main Toolbar When checked, the toolbar on the main window
is visible.
Local Toolbar When checked, the toolbar of the currently active

view is visible, if available.

Status Bar When checked, the status bar at the bottom of
the main window is visible.

4.4.4. Options Menu

There are various options associated with each window. These are selected
in the Options menu. When a particular window is selected or active, the
various options associated with that window are listed in the Options menu.
The list of options is unique for each window. The options list for each
window can be found below, under the window descriptions.

Photon Inc. B051007616-1.07
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4.45. Data Collection Menu

The Data Collection menu includes selections that determine or affect the
collection of data. When Data Collection on the Menu Bar is clicked, the
pull-down menu below appears:

Data Collection

Global Data Collection  Cirl+G

Auto Track Cirl+A
Acquisition Mode »
Trigger Mode »
Arquisition Resolution »
Averaging...

Image Flip »
Image Rotation 4

Camera Selection..
Camera Settings..

Calibration...
Background Correction »

Data Analysis. ..

Magnification Factor. ..

Angle Units r
Recompute Cirl+R.
Reset Al Views

Settings Status...

Global Data Collection Enables data collection and updates for all
windows.

Auto Track Selects the autotracking feature, which
automatically locates and tracks the laser beam
and defines an optimal region, called the Beam
Area, for performing data analysis.

Acquisition Mode Opens a menu for selecting 1 of 4 acquisition
modes.

Acquisition Mode Laser Positioning
v fnalysis

Choices are:

Laser Positioning Captures and displays images in the Video
window. No calculations are performed, thus
providing the fastest update rate. This mode is
intended for setup prior to acquiring quantitative

B051007616-1.07 Photon Inc.
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Analysis
Single Shot

Multiple
Samples...

Trigger Mode

CW

Pulsed

External

Acquisition
Resolution

1x

1/2x

data. Use this mode for positioning your laser in
the sensor aperture, adjusting attenuation, or for
visually tuning the laser.

Enables data analysis computations.
Currently inactive.
Currently inactive.

Opens a menu for selecting 1 of 3 trigger modes.

Trigoer Mode

Pulsed
External

Choices are:

Captures and displays images continuously. Use
this mode when measuring CW laser beams.

Captures and displays good images continuously.
Use this mode when measuring pulsed lasers
where external triggering is not available. In this
mode the software rejects invalid frames.

Captures and displays images whenever an
external trigger pulse is detected. Use this mode
when measuring pulsed lasers where external
triggering is available. In this mode the software
rejects invalid frames. This is the best mode for
your pulsed laser.

Opens a menu for selecting the acquisition
resolution to be used for computation and
analysis of video image pixel data. This feature is
intended for large laser beams, where the rate of
data analysis can be increased by reducing the
number of pixels used in the computations.

Acquisition Resolution o lx
1)2%

Choices are:

Analysis is performed using all the pixels in the
Beam Area.

Acquisition and Analysis is performed on every
other pixel in every other line in the Beam Area
(,e. only 1/4 of the pixels are used for
computations). The effective linear pixel
dimension is 2x the basic pixel dimension.

Photon Inc.
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Selecting 1/2x will increase the rate of acquisition, analysis, and data
display, depending on the analyses selected.

Averaging...

Image Flip

Image Rotation

Camera Selection...

Opens a dialog box for setting the number of
frames to average. Entire frames are sequentially
added up to the set value and then divided by the
number of frames to obtain an average frame. This
is not a rolling average; therefore, setting this
number higher will slow the update rate
significantly.

Averaging &|

Mumber of zamples T
o average; 1 Z‘

Cancel |

Opens a menu for selecting the orientation of the
image with respect to Vertical and Horizontal.
Select None to display the original frame,
Horizontal to flip the image about the horizontal
axis, Vertical to flip the image about the Vertical
axis. This operation takes precedence over Image
Rotation.

Image Flip 2 Mone

Horizonkal
Werkical

Opens a menu for selecting rotation of the image.
Select 0° to display the original frame, or 90°, 180°,
270° to rotate the image in clockwise direction.

s0°

180°

270°

Opens the Camera Selection dialog for selecting
USBeamPro cameras for use by Serial Number.

Camera Selection E|

Inztalled Cameraz: [SM 95050

Cancel |

B051007616-1.07
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Camera Settings...

Opens the Camera Settings dialog for setting the
camera Exposure Time, which ranges from 30us
to 30ms. The selected exposure time is displayed
at the top of the exposure slider.

The default setting for exposure is 30ms, and is
the recommended setting for highest specified
accuracy of £3%. When using shorter exposure
times, the accuracy is typically reduced
depending on the beam profile and diameter.

Camera Settings

Expozure Time

30,000 mz
S |

30.000 mz

0.030 ms

MHaotel  Accuracy depends on exposure.
See uzers manual for detailz.

Far best results, recalibrate after
changing expozLre.

Cancel

Photon Inc.
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Calibration...

Background
Correction

Frame

Mean

None

Opens the Calibration dialog for performing a
background calibration of the camera. The info
field displays the date and the time of the last
calibration. If the camera was not calibrated the
message “The system is not currently calibrated.”
is displayed.

To perform a calibration, simply follow the
instructions in the dialog box. First, block the
laser beam (as far from the camera aperture as
possible). Then click on the Calibrate button. The
calibration is complete when the OK button
becomes active. The current date and time will be
displayed in the info field. Then click on the OK
button to exit the Calibration dialog.

Camera Calibration E|

|S_I,Istem calbrated on: 2/14/2008 3:56:16 Phd.

Pleaze block the lazer beam.
Prezs the Calbrate buttan.
Prezs 0K, then releaze the beam.

Lok |
ol 2 —

Opens a menu for selecting the method of
background correction. The available choices are:

Background Correction 2 Frame

Mean

MNone

Selects the background frame correction method.
The background frame values are subtracted
from each data frame on a pixel-by-pixel basis.
Recommended for the Model 2323.

Selects the background mean value correction
method. The mean value of the background
frame is subtracted from each pixel value in the
data frame.

Selects no background correction.

B051007616-1.07
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Data Analysis

Opens the Data Analysis dialog for selecting the
calculations to be performed on each data frame.

Data Analysis g|

ISO Profiles
o« [ slit

" D energy Cancel

£ D Asigma
=5 Iw Flat Top Analysis

ThrezholdlZ]: |0

[v Elliptical &nalyzis

v Energy

v Gaussian Fit 1 u”itS:I—L|
Divergence
i
* Lens

P Focal lengthimm]; {100
(™ Point Source ocal lengthimen]
" Mumeric Aperture Cliplevel(%): [13.5

The various selection choices are:

Selects the method of ISO Profiles beam width
computation. Choose from 1 of 3 possible
selections:

Selects the slit method for determining beam
widths. The computation simulates a scanning slit
aperture with slit width equal to the effective pixel
dimension of the camera used for measurement.
Scans are performed along the horizontal and
vertical directions or along the directions of the
major and minor axes if elliptical analysis is
selected.

Selects the encircled energy method for
determining beam widths. The computation
simulates circular apertures centered at the laser
beam centroid and calculates the energy through
the aperture. The diameter of the circular
aperture is increased until the specified energy
percentage is obtained.

Selects the second moment method for
determining beam widths. The computation
determines the second moment of the laser beam
distribution.

ISO Profiles
D slit
D energy
D 4sigma
Photon Inc.
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Elliptical
Analysis

Gaussian Fit:

Flat Top Analysis

Threshold
(%)

Energy

Divergence

Off
Lens

By default, data analysis is performed along the
horizontal and vertical directions of the pixel
array. If the Elliptical Analysis box is checked,
the analysis will be performed along the
directions of the major and minor axes of the
beam.

To enable Gaussian fit calculations of the profiles
displayed in the Profile window (either Slit or
Pinhole scans), check the box labeled Gaussian
Fit. The Gaussian fit to the profiles can then be
displayed as overlays on the profiles in the
Profile window by selecting the Fit option for that
window. The corresponding Gaussian Goodness-
of-Fit parameter can be displayed in the Beam
Statistics Parameters or the Time Statistics
window.

Enables Uniformity or Flat Top Analysis of
Energy Region of Interest (ROIl). The Energy ROI
is a user-defined region in the Video window.

Defines the threshold as a percentage of the
peak pixel value for which the Flat Top Analysis
will be performed. Only those pixels in the Energy
ROI that are greater than this value are included
in the analysis.

When selected, the total energy or power in the
Beam Area is computed. A reference energy or
power value, (from independent measurements
with an energy or power meter), and the
appropriate units must be entered. In addition, the
energy or power in the Energy ROI and the
percentage of the energy in the Beam Area are
computed in the Flat Top Analysis, if enabled.
Also, the Min, Mean, and Max values in the Flat
Top Analysis will be reported as Fluence or
Irradiance per pixel.

Selects the method for divergence computation.
Choose from 1 of 4 possible selections:

No divergence computations will be made

Selects the Lens method for computing
divergence. When selected, the lens focal length,
in millimeters, and the beam width clip level
percentage must be specified.

B051007616-1.07
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Point Source

Numerical
Aperture

Magnification
Factor...

Angle Units

Selects the Point Source method for computing
divergence. When selected, the distance from the
point source to the measurement plane, in
millimeters, and the beam width clip level
percentage must be specified.

Selects the Numerical Aperture method for
computing divergence. When selected, the
distance from the point source to the
measurement plane, in millimeters, and the beam
width clip level percentage must be specified. The
numerical aperture equivalent of the divergence
half-angle is reported (sin(6/2)).

Opens a dialog box for entering an optical
magnification factor that will scale the camera pixel
dimension. This is necessary to obtain accurate
beam width values whenever optical components
such as lenses or mirrors with magnification are
used to image a laser beam. It allows
compensation of any optical or imaging schemes
that change the size of the beam image. This
factor is used to scale the linear pixel dimension of
the camera selected for measurements. The
default magnification factor is 1.

External Optics Magnification Factor E|

E nter the magnification factar for any
front end optics along the path

between your lazer beam and the Cancel
Cammera.

For instance, if pou have a small beam
and the opticz enlarge the image by 2,
enter 2.

|1

Opens a menu for selecting the units need for
reporting all the angles, either miliradians or
degrees.

Angle Units 3w Miliradians

Degrees

Photon Inc.
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Recompute Click on Recompute to redo computations on the
image data currently in memory. Use this feature
if any changes to the analysis are desired, e.g.,
changing the method of beam width computation,
or changing the Beam Area or the Energy ROI to
analyze a different region of the image.

Reset All Views Resets all open data-display windows.

Settings Status... Opens the Status screen dialog, which displays
the current program settings.

Status &|

Yideo Format; [hgital BeamProfiler - 10 Bit
Carnera Mame: I15BearmPro SM 35050
Equivalent Pizel Dimensian: G. 700 prn

Camera Exposure:; 30,000 mz

Acquizition kode: Analyzis

Trigger Mode: i

Acquizition Fesolution; 1=

Background Comection: MHone

150 Profile: Slit

b agnification Factar: 1.000

4.4.6. Window Menu

When Window on the Menu Bar is clicked, the pull-down menu below appears.

I|I|'|I|I | M |j [miry]

Few Window *

Cascade
Tile
Arrange Icons

Close All

v 1 wideo - Photon Inc,
Z Beam Skatiskics 10 samples - Photon Inc,
3 Profile - Photon Inc,
4 30 Wiew - Photon inc,
5 20 Wieww - Photon inc,
& Time Statistics For Beam Width - Photon Inc.
7 Pointing - Photon Inc,
& Motes - Photon Inc,

B051007616-1.07 Photon Inc.
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The Window menu is used to open new windows, arrange windows and
window icons and to close all open windows. The list at the bottom of the menu
shows which windows are open with the currently active window checked.

New Windows Opens a menu for selecting windows for viewing.
e indow Beam Profile  FZ2
YWiden F3
30 Profile F5

20 Conkour F&

Bearmn Skatistics F7
Time Skatistics  F3

Painking F11
Motes F1z
Cascade Arranges the open windows in cascade format.
Tile Arranges the open windows in tile format.

Arrange Icons Arranges the minimized window as icons on the bottom
of the main window.

Close All Closes all open windows.

Window List Displays a list of all open windows and displays a check
before the currently active window name.

4.4.7. Help Menu

Use the Help menu to access Help Topics, and the About USBeamPro
dialog box. Help Topics are currently unavailable.

Abouk USEeamPro, .,

Photon Inc. B051007616-1.07
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4.5. Window Descriptions

45.1. Profile

> | ALA

Horizontal axis

0.6

04

0.2

| 1 1 | |
e 600 -400 -z00 o 200 400 3
Vertical axis

The Profile window displays either Pinhole or equivalent Slit profiles in
orthogonal directions along the crosshairs displayed in the live Video
window. An example of the Profile window is given above. If data analysis is
set to the default XY mode, then the profile axes are horizontal and vertical. If
data analysis is set to Elliptical Analysis Mode, then the profile axes are
oriented along the major and minor axes of the laser beam image.

The locations of the Pinhole profiles are identified by the crosshairs in the
Video window. The pinhole profile locations can be selected to be through
either the beam centroid, the peak pixel, or through user selected points by
dragging the crosshairs with the mouse to the desired location. Also, when in
elliptical analysis mode, the orientation of the axes can be changed arbitrarily
by holding down the control key and using the mouse to rotate the axes.

For Slit profiles the crosshairs identify the direction of the equivalent slit scan.

B051007616-1.07 Photon Inc.



Chapter 4. Acquisition and Analysis Software 4.25

The Options menu available when the Profile window is active is shown

below.

The selections are:
Data Collection

Cipkians

v Data Colleckion Crrl+Dr

Timing...

Fit

Marmalize

Scale »
Prafile »

Turns data collection on/off.

Timing... Opens a dialog box for selection of the profile
update rate.
Plat Frequency
27 Updatez/Sec =
Cancel |
Fit Places a blue-colored Gaussian fit overlay on the
profiles if Gaussian Fit 1D is enabled in the Data
Analysis dialog box.
Normalize Scales the profile amplitude to have a peak value
of 1, i.e. full scale.
Profile Selects either the Pinhole or the Slit profiles for
display.
 Prfe
Slit
Scale Allows the user to choose between a Linear and
a Logarithmic scale.
A Linear
Logarithric
Photon Inc. B051007616-1.07
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These options can also be selected using the Profile window toolbar:

v [m | AlLA
» Starts data collection.
. Stops data collection.
% Turns Gaussian Fit overlay on/off.
o Turns Normalization on/off.

45.2. Video

The Video window displays the video laser image. An example of the Video
window is given below.

The crosshairs in the image identify the location and/or direction of profiles
displayed in the Profile window, depending on the type of profile selected,
either Pinhole or Slit, in the Profile options. If data analysis is set to the
default XY mode, then the profile axes are horizontal and vertical. If data
analysis is set to elliptical mode, then the profile axes are oriented along the
major and minor axes of the laser beam image.

For Pinhole profiles the pinhole profile locations can be selected to be
through either the beam centroid, the peak pixel, or through user selected
points by dragging the crosshairs with the mouse to the desired location.
Also, when in elliptical analysis mode, the orientation of the axes can be
changed arbitrarily by holding down the control key and using the mouse to
rotate the axes.

For Slit profiles the crosshairs identify the direction of equivalent slit profiles.

* [¥ideo - Photon Inc.

@li|e|=(n]

B051007616-1.07 Photon Inc.
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The Options menu available when the Video window is active is also shown
below.

Cipkians

v Data Collection  Crrl4+D
Timing. ..

Select Calars, ..
Wiew Finder

Zoam Fackor L4
v Aubo Position

Crverlays »
Set Beam Area
Set Energy ROL 4
The selections are:
Data Collection Turns data collection on and off.
Timing... Opens a dialog box for selection of the display

update rate.

Flot Frequency
27 lpdatess/Sec -

Cancel |

Select Colors... Opens a dialog box for selection of the display
color scheme. Choices available are: Rainbow,
Gray, Red, Green and Blue.

Select Colors

Select Color Scale

{*+ Rainbow
" Gray

" Bed

" Green
" Blue

Photon Inc. B051007616-1.07
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View Finder

Zoom Factor

Auto Position

Overlays

Cross Hairs

Opens a display box that shows the entire
camera video image (1280 x 1024 pixels).

View Finder  [X]

Opens a menu for selecting the zoom factor.
Choices available are: 1:2x, 1x, 2x, 4x, 8x, 16x,
and Fit to Window proportional to the camera
array dimension of 1280 x 1024 pixels.

When auto position is selected the laser beam
image will automatically be positioned in the
displayed portion of the Video window.

Opens a menu for selecting which overlays will be
displayed in the Video window. Choices available are:

Zross Hairs k
W Sensars Areas
v Beam Area
v Energy ROI

Selecting Cross Hairs opens a second menu with
the following choices:

Cross Hairs r Cff Ckrl+F
v Centroid Chrl+T
Peal: ChelHE

ser Defined  Chr+E

The selection is available only if the Pinhole is
selected under the Profile option in the Profile
Window. When the Profile display is set to Slit, the
Cross Hairs are drawn through the centroid and
cannot be moved, so no other selections can be
made.

B051007616-1.07
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Off

Centroid
Peak

User Defined

Beam Area
Energy ROI

Set Beam Area

To set Beam Area
using the mouse:

To set Beam Area
using coordinates:

Redraw

Close

Cancel

Turns the cross hair overlay off or on.
Places the cross hairs at the centroid.
Places the cross hairs at the peak.

Allows the cross hairs to be positioned manually
at an arbitrary position using the mouse.

Turns the Beam Area overlay off or on.

Turns the Energy ROI overlay off or on if Flat Top
Analysis is enabled.

Allows the user to set a Beam Area manually.

The beam area can be defined/adjusted using the
mouse or defining the top, left, width and height
coordinates.

First click on Set Beam Area. Next, use the
mouse to draw and/or adjust the desired beam
area in the Video window. Finally, click on Set
Beam Area a second time to validate the Beam
Area previously drawn. In drawing/adjusting mode,
depress ESC to discard all the changes and revert
Beam Area to its original size and position.

Note: Selecting the Set Beam Area will also open
(or close) the Beam Area—Position/Size dialog
box.

In the Beam Area—Position/Size dialog box,
enter the Top, Left, Width and Height coordinates
in the designated edit boxes.

Beam Area - Position/Size

Left [pm]: |EO03.6 Top [pm]: (1019.5
Width [prm]: |483.75 Height [pm]: (483.75

Cloze | Cancel |

Redraws the beam area based on the new
coordinates and keep the Beam Area-
Position/Size dialog box open.

Closes the dialog box.

Ignores any changes made during the
drawing/adjusting mode, reverts Beam Area to its
original size and position and closes the dialog box.

Photon Inc.
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Set Energy ROI

To set Energy ROI
using the mouse:

Allows the user to set the Energy ROl manually.
The ROI can only be drawn inside the Beam Area.
The ROI can be defined/adjusted using the mouse
or defining its coordinates.

Set Energy ROI Reckangle
Square
Elliptic
Circle

Note: Flat Top Analysis must be enabled for the
Energy ROIs to be available.

First click on Set Energy ROI; this opens a
second menu with the following selection choices.
Rectangle, Square, Elliptic, and Circle. Click on
one of these to determine the general shape of the
Energy ROI to be drawn. Next, use the mouse to
draw and/or adjust the desired Energy ROI in the
Video window. Finally, click on the shape selection
a second time to validate the Energy ROI
previously drawn. In drawing / adjusting mode,
depress ESC to discard all the changes and revert
Energy ROI to its original size and position.

Note: Selecting the one of the Set Energy ROI
item will also open (or close) the corresponding
Energy ROI — Position/Size dialog box.

To set Energy ROI using coordinates:

Rectangle:

Enter the Left, Top, Width and Height
coordinates for the Rectangle Energy ROI.

Energy ROI (Rectangle) - Position/Size E|

Left [pm]: |6003.9 Top [pm]: (1078.4
Width [pm]: |475.7 Height [pm]: |475.7

Cloze | Cancel |

B051007616-1.07
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Square: Enter the Left, Top coordinates and the Size for
the Square Energy ROI.

Energy ROI (Square) - Position/Size [g|

Left [pm]: |E009.9 Top [pm]: (1013.4
Size [um]: |475.7

Cloze | Cancel |

Elliptic: Enter the Left, Top coordinates and the
Horizontal Axis and Vertical Axis for the
Elliptical Energy ROI.

Energy ROI (Elliptic) - Position/Size rg|

Left [pm]: |6003.9 Top [pm]: (1078.4
H. Axiz [pm]: 4757 Wbz [pm] |475.7

Cloze | Cancel |

Circle: Enter the Left, Top coordinates and the Diameter
of the Circle Energy ROI.

Energy ROI (Circle) - Position/Size [g|

Left [pm]: |E009.9 Top [pm]: (1013.4
Diarneter [pm]: |475.7

Cloze | Cancel |

Redraw Redraws the beam area based on the new
coordinates and keep the Energy ROI-Position/
Size dialog box open.

Close Closes the dialog box.

Cancel Ignores any changes made during the
drawing/adjusting mode, reverts Energy ROI to its
original size and position and closes the dialog
box.

Photon Inc. B051007616-1.07
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The Beam Area and Energy ROI drawing functions can also be accessed on
the Video window toolbar: (Note: The ROI drawing tools are only available if
Flat Top Analysis is enabled.)

a| (]

Set Beam Area drawing tool.

Energy ROI: Elliptical region drawing tool
Energy ROI: Circular region drawing tool
Energy ROI: Rectangular region drawing tool

Energy ROI: Square region drawing tool

45.3. 3D Profile

The 3D Profile window displays the laser beam image in a ‘3-dimensional’
viewing format. The laser beam image can be rendered with either a
wireframe or solid surface, with user selected clip levels and colors.

= 3D View - Photon Inc.

Rotx Roty [[IIILCCC DO Zoom <| | »|| 45.0 Dolly

B051007616-1.07 Photon Inc.
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The Options menu available when the 3D Profile window is active is shown

below.

The selections are:
Data Collection
Timing...

Clip Level...

Cipkions

v Data Collection Chrl+D
Timing. ..

Clip Lewel. ..
v Clip Legend

Fill Cantaurs
v Salid Surface

Resolution »
Scale »

Turns data collection on and off.

Opens a dialog box for selection of the display
update rate.

Plot Frequency
27 | Ilpdates/Sec -

Cancel |

Opens a dialog for selecting clip level contours
and their colors.

Colar Chp Lewvel

100.0% Clip Level
90.0%
75.0%
60.7%

L0.0%

35_3% o Calor

Add | Delete |

Caricel |

This option is not available for data displayed
using the logarithmic scale. In this case, the
contour levels are fixed at the 0, -3, -5, -10, -13,
-20, -23, -30, and the -33 dB levels.

Photon Inc.

B051007616-1.07



4.34

USBeamPro Installation and Operation Manual

Clip Legend

Fill Contours

Solid Surface

Resolution

Scale

When selected, the Clip Level legend will be
displayed in the view.

When selected, the different clip levels on the
beam will be clearly delineated. Please be aware
that this option will slow the acquisition rate of
the system.

When selected, the image will have a solid
surface. When not selected, the image will be
rendered as a wireframe.

Opens a menu for selecting the resolution of the
3D display. Choices are: High, Medium, Low.
Data update rate is reduced and image
manipulation is slower as resolution is increased.

Resaolution High
Medium
W Low

Allows the user to choose between a Linear and
a Logarithmic scale.

A Linear
Logaritbiric

The toolbar at the right border of the window contains 8 buttons used to
select several viewing and image manipulation features. These buttons are,
from top to bottom:

k

N

B |2 [

Chooses the Arrow cursor, which allows image
manipulation only using the mouse and the
thumbwheel controls.

Chooses the Hand cursor, which allows image
manipulation using the mouse directly in the
image or by using the thumbwheel controls.
(When the mouse is moved to the window
border the Hand cursor changes to the Arrow
cursor).

This Help menu is inactive.

Resets the view to a preset Home default
position, size and orientation.

Sets the default settings for the Home button.

Restores the view to include the entire image.

B051007616-1.07
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|

&l 8

[l i EEEEEEEE ]

Activates the Seek cursor. After positioning this
cursor on a selected point in the image and
clicking the left mouse button, a close-up zoom
to that point will be performed automatically.
Also, the center of rotation will be set to that
point.

Toggles between the Perspective and
Orthographic projection modes.

There are also three thumbwheels along the
window border, designated Dolly, Rotx, and
Roty, which are used to zoom and rotate the 2D
image.

The image can be rotated, translated, panned, and zoomed using the mouse
with the Arrow cursor and the thumbwheel control knobs or using the mouse
with the Hand cursor, as described below.

Rotation

Pan/Translate

Zoom

Rotate the image using the mouse and the
Arrow cursor with the thumbwheels labeled
Rotx and Roty. Alternatively, use the mouse
and the Hand cursor to directly rotate the
image; Position the hand cursor over the image,
depress the left mouse button, and drag the
mouse to obtain the desired orientation.

While depressing the control key <CTRL>, use
the mouse and the Hand cursor to directly pan
the image. Position the hand cursor over the
image, depress the left mouse button, depress
the control key, and drag the mouse to move
the image to the desired location.

The method for zooming the image depends on
the type of display projection selected. In the
Perspective projection mode, use either the
zoom control scroll bar at the bottom of the
window, or use the Dolly thumbwheel at the
lower right border of the window. In the
Orthographic projection mode, use the Zoom
thumbwheel at the lower right border of the
window. You can also zoom by using the
mouse. To zoom in (out) hold the Ctrl+Shift keys
down and drag the mouse toward (away from)
the center while holding the left mouse button.

Photon Inc.
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45.4. 2D Contour

The 2D Contour window displays the laser beam image with user specified
contour overlays. An example of the 2D Contour window is shown below.

= 2D View - Photon inc.

(B | x> |-~ | [

60.7

50.0

36.8

25.0

13.5
5.0

ClipLevels(a)

Rotx Roty [T LTI Zoom «| | || 45.0 Dally

The Options menu available when the 2D Contour window is active is
shown below.

Cipkions

v Data Collection Chrl+D
Timing. ..

Clip Level. ..
v Clip Legend

Fill Cantours
v Solid surface

Resolukion »
Srale »

B051007616-1.07 Photon Inc.
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The selections are:
Data Collection
Timing...

Clip Level...

Clip Legend

Fill Contours

Solid Surface

Turns data collection on and off.

Opens a dialog box for selection of the display
update rate.

Plat Frequency
27 | lpdatez/Sec -

Cancel |

Opens a dialog for selecting clip level contours
and their colors.

Color  Clip Lewvel

100.0% Clip Level

90.0%

5.0%

b0.7%

L0.0%5

35_3% vEDhIIr

add | Delete |
Cancel |

This option is not available for data displayed
using the logarithmic scale. In this case, the
contour levels are fixed at the 0, -3, -5, -10, -13,
-20, -23, -30, and the -33 dB levels.

When selected, the Clip Level legend will be
displayed in the view.

When selected, the different clip levels on the
beam will be clearly delineated. Please be aware
that this option will slow the acquisition rate of
the system.

When selected, the image will have a solid
surface. When not selected, the image will be
rendered as a wireframe.

Photon Inc.
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Resolution

Scale

Opens a menu for selecting the resolution of the
3D display. Choices are: High, Medium, Low.
Data update rate is reduced and image
manipulation is slower as resolution is increased.

Resaolution High
Medium
W Low

Allows the user to choose between a Linear and
a Logarithmic scale.

A Linear
Logaritbiric

The toolbar at the right border of the window contains 8 buttons used to
select several viewing and image manipulation features. These buttons are,

from top to bottom:

R

&

& B ez |2 |

8 8

(MO

Chooses the Arrow cursor, which allows image
manipulation only using the mouse and the
thumbwheel controls.

Chooses the Hand cursor, which allows image
manipulation using the mouse directly in the
image or by using the thumbwheel controls.
(When the mouse is moved to the window border
the Hand cursor changes to the Arrow cursor).

This Help menu is inactive.

Resets the view to a preset Home default
position, size and orientation.

Sets the default settings for the Home button.

Restores the view to include the entire image.

Activates the Seek cursor. After positioning this
cursor on a selected point in the image and
clicking the left mouse button, a close-up zoom
to that point will be performed automatically.
Also, the center of rotation will be set to that
point.

Toggles between the Perspective and
Orthographic projection modes.

There are also three thumbwheels along the
window border, designated Dolly, Rotx, and
Roty, which are used to zoom and rotate the
image.

B051007616-1.07
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The image can be rotated, translated, panned, and zoomed using the mouse
with the Arrow cursor and the thumbwheel control knobs or using the mouse
with the Hand cursor, as described below.

Rotation

Pan/Translate

Zoom

Rotate the image using the mouse and the
Arrow cursor with the thumbwheels labeled
Rotx and Roty. Alternatively, use the mouse and
the Hand cursor to directly rotate the image;
Position the hand cursor over the image,
depress the left mouse button, and drag the
mouse to obtain the desired orientation.

While depressing the control key <CTRL>, use
the mouse and the Hand cursor to directly pan
the image. Position the hand cursor over the
image, depress the left mouse button, depress
the control key, and drag the mouse to move the
image to the desired location.

The method for zooming the image depends on
the type of display projection selected. In the
Perspective projection mode, use either the
zoom control scroll bar at the bottom of the
window, or use the Dolly thumbwheel at the
lower right border of the window. In the
Orthographic projection mode, use the Zoom
thumbwheel at the lower right border of the
window. You can also zoom by using the mouse.
To zoom in or out hold the Ctrl + Shift keys down
and drag the mouse toward (away from) the
center while holding the left mouse button.

Photon Inc.
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455. Beam Statistics

The Beam Statistics window, as shown below, displays a tabular summary
of beam parameters and statistics. Any or all of the computed beam
parameters set up in the Data Analysis dialog may be viewed in this way. It
is also used for Limit Analysis. The parameters for viewing are selected in the
Beam Statistics Parameters dialog box.

sz Beam Statistics 100 samples - Photon Inc.

b Lm || ]
Parameter | Walue | Mean | Min ax Std Dev bin Limit ax Limit |
O 13.52% Width Maior ) 5162 1677 5120 5220 222 500.0 5200
O 1352 Width Minor ) G03.4 G058 95 G04.4 5138 1.96 500.0 5200
36.8% Width Major [um] 3638 36863 3631 3745 210
36.8% Width Minor [pm] 3632 36324 3E3E 748 210
B0.0% Width Major [pm] a07.4 30609 2003 24 214
B0.07% Width Minor [pm] 2024 0787 a04.3 b | 153
B0.7% Width Major [pm] 2552 25457 2465 2602 238
B0.72% Width Minor [pm] 2633 261.42 2573 266.0 197
80.00% Width Maior ) 165.4 16761 1630 1726 1.8
80,002 Width Minor ) 1634 17213 1667 177.4 1.9
Ruotation Angle [deg) E1.91 BE.E74 E1.15 24 212
O Ellipticity 093 0.935 0.7 1.00 0.007 nae 1.00
E coentricity 016 0168 004 0.24 0.041
Centroid Horiz [um) 51800 518007  B18EF  B1934 0.94
Centroid Yert [lm] 27766 277E14 2WFR2 TERL2 033
Peak Hariz (um) 51325 519593 51858 51332 387
Peak Vert [um) 27671 2YB3YE 27D3F 27805 410
Irradiance [cht) 795 a01.4 794 a1 31
v Tatal Energy [J) 0.36 0.957 0.35 0.96 0.00z 1.00 1.20
Flat Top bin [ /emd) kral 366D 358 72 33
Flat Top bdax [ /omé] 444 4520 943 963 el -3
Flat Top bean [J/emé] B33 B30628  B2963  B3330 0.559
Flat Top Flatness 067 0.662 065 067 0.00z
Flat Top Uriformity 0.23 0.235 0.23 0.24 0.000
Energy in ROI L) 0.52 057 052 052 0.000
Energy Percentage in RON (%) 53.87 53.971 53.85 5412 0.055
13.5% Divergence M ajor [deg) 0.296 0.2961 0233 0239 0.0013
13.5% Divergence Minor [deg) 0.292 0.2916 0.289 0.294 0.0011
GG aussian Fit Major 0.96 0.944 041 087 oo
Gausgian Fit Minor 0.92 0833 0.0 0.96 0ms

Limit Analysis

Limit analysis can be performed on any of the parameters reported in the
Beam Statistics window. The parameters are checked against user
specified maximum and/or minimum values and the result of the analysis is
displayed using icons in the Beam Statistics window, as shown above. To
configure the analysis, either double click with the left mouse button on the
desired parameter, or, alternatively, use the Up/Down Arrow keys to
highlight the parameter and then press the Space key. This will open the
following dialog box for setting the parameter limits for the analysis.

13.5% Width Horiz {pm)

I biirnuim 4 alue: |535 (1] 4 |
v M awimum Yalue: 545 Cancel

B051007616-1.07 Photon Inc.
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Either one or both limits can be set. The icons for reporting the analysis are:

O
Fy

v

Parameter value is within the set limit or limits.
Parameter value is greater than the maximum
limit.

Parameter value is less than the minimum limit.

The Options menu available when the Beam Statistics window is active
offers the following selections:

Data Collection

Timing...

Reset
Parameters...

Data Collection Ctrl4+D
Timing...

Reset
Parameters...

Font...

Log Ctrl+

Turns data collection on and off.

Opens a dialog box for selection of the display
update rate.

Timing E]

Plat Frequency
27 | lpdatez/Sec -

Cancel |

Resets the Beam Statistics table.

Opens the Beam Statistics Parameters dialog,
shown below, for selecting the parameters to be
listed in the Beam Statistics table. Parameters
available for selection are determined by the
selections made in the Data Analysis dialog.
Those parameters that are unavailable for display
are grayed out in the dialog box. This dialog is also
used to select which statistical quantities to list in
the table for each parameter selected and how the
statistics will be calculated. All the parameters are
computed in accordance with ISO Standards. In
addition, the setup for data logging to files or serial
communication ports is made here.

Photon Inc.
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Selection options in the Beam Statistics Parameters dialog box are listed below.

Beam Statistics Parameters

1 3_52 Statistics
[v 35.8% " Continuous
[v B0.0% ~ ' Cancel
W EO0.7% Ralling
[v Userk |80 % Firite |10
Elliptical Analysis .
v Rotation Display
v Elliticity v alue
v Eccentriciy v hean

. [+ Minirmumm

Ilgath'!'ll!:up.-’-'-.nalysm v Masimum
W Mg-l:li-:nuur:n [v Standard Deviation
¥ Mean v Minimurn Lirnit
[v Flatness [v  tazimarn Lirnit
[v Unifarrmity Logai
W Enerav%] Djtifj[‘g
- ‘
II: Ener¥;n ROI ~ None
v Lentrol
v Peak  File |Test J
[v Iradiance “ Pt I—_|
[w Total Energy
g ggﬁsrgiea:ﬁ?it Delimiter; Comma -
Puairting [+ Date
[+ Position ¥ Time
v Anale
v Fadiuz W Serial Mumber:  |2323

Note: If a selection is not available or grayed out in this box, that option must
first be turned on in the Data Analysis dialog box. In order to do this, go to
Data Collection, select Data Analysis and then mark the appropriate

selection.

Beam Width
13.5%

36.8%
50.0%
60.7%
User %

Elliptical Analysis

Rotation

(86.5% encircled energy), horizontal and vertical
or major and minor axes.

(63.2% encircled energy), horizontal and vertical
or major and minor axes.

(50.0% encircled energy), horizontal and vertical
or major and minor axes.

(39.3% encircled energy), horizontal and vertical
or major and minor axes.

User Specified Value, horizontal and vertical or
major and minor axes.

Angle of the major axis with respect to horizontal

B051007616-1.07
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Ellipticity

Eccentricity
Flat Top Analysis

Min

Max

Mean

Flatness

Uniformity

Energy %

Energy in ROI
Centroid

Peak

Irradiance

Total Energy

Divergence

Gaussian Fit

Pointing
Position
Angle
Radius

Statistics

Continuous
Rolling

Finite

Ellipticity Factor
Eccentricity Factor

Minimum value in the Energy ROI
Maximum value in the Energy ROI
Mean value in the Energy ROI
Flatness Factor

Uniformity Factor

The percentage of Beam Area total energy or
power in the Energy ROI.

The energy or power in the Energy ROI

Location of the beam centroid reported in
microns (um) from the upper left corner of the
image in the Beam Area.

Location of the peak of the image in the Beam
Area.

The value of the irradiance at the peak location.

The value of the total energy or power in the
Beam Area.

Beam Divergence angle

Gaussian Goodness-of-Fit Value

The beam area Centroid from the Pointing
window.

The pointing angle from the Pointing window.

Distance from the reference position in the
Pointing window.

Selects a continuous average of data samples.

Selects a rolling average with user-specified
number of samples.

Selects a finite average with user-specified
number of samples.

Photon Inc.
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Display

Value
Mean
Min

Max

Std Dev
Min Limit
Max Limit

Logging
Output
None
File

Port

Delimiter
Date

Time

Serial
Number

Font...

Log

Selects display of the present value of the beam
parameter.

Selects display of the mean value of the beam
parameter.

Selects display of the minimum value of the
beam parameter.

Selects display of the maximum value of the
beam parameter.

Selects display of the standard deviation of the
beam parameter.

Selects display of the minimum limit value of the
beam parameter set in Limit Analysis.

Selects display of the maximum limit value of the
beam parameter set in Limit Analysis.

No data logging.
Data logging to specified file.

Opens a Save As dialog box for selecting the
path and file name for the log file. After you click
OK the full path and file name will be displayed
in the File edit box.

Data logging to serial port COM1 or COM2.

Selects the delimiter format for the logged data.
If selected, the date is attached to the logged file.

If selected, the time is attached to the logged file.

If selected, the specified serial number is
attached to the logged file.

Opens a dialog box for selecting the type and
size.

If data logging is enabled, one additional set of
data is acquired and then displayed and/or
logged to the file. If data collection is disabled for
the Beam Statistics window, it allows the user to
take individual data one set at a time and log into
a file. The Hot Key ‘Ctrl+L’ enables logging even if
another window is active as long as the Beam

B051007616-1.07
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Statistics is open.

Some options can also be selected from the Beam Statistics window
toolbar:

SEEE

Starts data collection

»

n Stops data collection

X Resets table

e Opens Beam Statistics Parameters dialog

45.6. Time Statistics

The Time Statistics windows display strip charts of beam parameters versus
time. Any or all computed beam parameters may be viewed in this way. Up to
15 Time Statistics windows can be opened. Several overlays are available
in the Options menu, including grids, statistical markers, and numerical
statistical summaries.

» | Time Statistics for Beam Width - Photon Inc.

x| [ |1

v

522

520

a12

a10

20 30 40 a0 60 70 a0

Points

90 100 10 120 130 150 160

13.5% Width Horiz (pm)

13.5% Width Vert fum)|

“ariable
13.5% WWidth Horiz (pm
13.5% WWidth ert (pm)

Mean

5157
4161

Min
514.3
514.5

ax
517.2
517.5

StdDev
0.5230
0.6448

Photon Inc.
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The Options menu available when the Time Statistics windows are active
offer the following selections:

Data Collection
Timing...

Reset Graph

Grid On

Mean

Min/Max

Opkions

v Daka Collection Chrl+D
Timing. ..

Reset Graph
v (arid On
Mean
Felim Pl
Standard Deviation
Shows Calculations

Fornk...
Paramekers...
bxes,.,

Turns data collection on and off.

Opens a dialog box for selection of the display
update rate and for how long data will be
acquired in the active chart. If Manual is
checked, one set of data points will be acquired
each time the user selects Data Collection.

Time Stat Timing

Automatic [ ata Collection
Fate itz Diwration itz

10 j‘ Updates/Sec - 10000 ﬂ Puaints hd

b anual Data Collection
Murnber of Points

[ Manual 10000 =]
=l

Cancel |

Resets the active Time Statistics window. (A
message prompt warns the user that old data will
be lost).

When selected, a grid overlay is displayed on the
Time Statistics graph.

When selected, an overlay plot of the mean
value is displayed.

When selected, overlay plots of the minimum
and maximum values are displayed.

B051007616-1.07
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Standard Deviation

Show Calculations

Font...

Parameters...

AXesS...

When selected, an overlay plot of the standard
deviation is displayed.

When selected, the numerical values of the
mean, minimum, maximum, and standard
deviation values are displayed beneath the plot
area.

Opens a dialog box for selecting the font type
and size.

Opens the Parameters dialog box for selecting
parameters to be plotted in the active Time
Statistics window.

Parameters P§|

|Beam Width |
Cancel
Beam 'Width Dizplay & Color
f« 13.5%

" 3EE% M| © 13.5% width Hariz [pm)
(" B0.0% | 13.5% width Vert [um)
b fon  Both

. Llseril_

The choice of parameters are limited to those
which are presently being computed, as set up in
the Data Analysis dialog accessed in the Data
Collection menu. These are the same
parameters available to the Beam Statistics
window. In addition to selecting the parameters
to be plotted, this dialog is used to set the color
of the plotted lines.

Opens a dialog box for selection of manual or
automatic configuration of the axes in the Time
Statistics display.

Time 5tat Axes &|

¥ iz iz
kit in nits

I j |'I ﬂ |F'|:|ints j
G EN [EN

Iﬂij [v Awito Wﬂ v Auto
(] 8 | Cancel |

Photon Inc.
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Some of the options can be selected using the Time Statistics window

toolbar:
3 x | [H[xe 2L

Starts data collection

>

- Stops data collection

o Resets table

H Grid overlay on/off

% o Statistical calculations overlay on/off

= Opens Beam Statistics Parameters dialog
1. Opens the Time Stat Axes dialog

45.7. Pointing

The Pointing window displays a screen that shows and tracks the location of
the beam centroid with a colored dot or cross. An example is shown below.

i1 Pointing - Photon Inc. E‘@JE|
0,1000
-1000,0 1000,0
Zoom| ~ |
0,-1000 ll
Hariz. Vert. Radius | Angle
(um) (um) (um) | (mrad)
Rel Cur. Pos. - 134 2.49 2.83 0.028
Rel. Max. Pos. 1.81 366 366 0.037
Reset Distance | 100.0 mm
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It also displays a table showing the relative current position and the relative
maximum position in the horizontal, vertical, and radial directions, and the
corresponding angular displacement. Clicking on the colored box in the
window opens a color selection dialog for choosing the color of the beam dot
or cross indicator. A zoom control allows the user to scale the aperture of the

pointing screen.

The Options menu available when the Pointing window is active is shown

below.

The selections are:

Data Collection

Timing...

Centroid Cross

Accumulate

Opkions

v Data Collection Chel4+D
Tirning. ..

v i_enkraid Cross
Accumulate

Parameter Averages...
Defaulk r

Turns data collection on and off.

Opens a dialog box for selection of the display
update rate and for how long the window will
update.

Timing & Duration g]

Frequency

n |L||:u:|ates.-"Sec -

Diuration
1 | Hours -

Cancel |

Selects the cross indicator for the centroid. If not
selected the indicator is a dot.

Turns on the Accumulate mode, which displays
centroid values for all subsequent data on the
same plot, allowing observation of beam
movement.

Photon Inc.
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Parameter Averages... Opens a dialog for setting the number of points
to be used in a moving average of the centered

value.

Data Smoothing E'

# af Paintz in Maoving Average
1 =]
r=1]

Cancel |

Default Lo

Save
Load Opens a dialog for loading a previously saved
pointing screen setup.
Save Opens a dialog for saving a pointing screen
setup.

4.5.8. Notes

The Notes window is used for entering user information. When active, a
cursor appears in the Notes window. Use the keyboard to enter text, and the
arrow keys to navigate. There are no options available for the Notes window.

7= Notes - Photon Inc. |Z||E|[E|

Laser Test
SN B7245
JLG|
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4.59. K-Factor (M? Wizard)

The K-Factor Wizard window is an interactive program for determining the
K-factor by the Rayleigh Method. The K-Factor Wizard window is a series of
dialog boxes that prompt and guide the user through a series of
measurements and data entries required for calculating the K-factor and M?.
The calculated values are displayed in the final dialog box.

7= K Factor Wizard - Photon Inc.

Step 1. Beamwaist Measurement

Enter the laser wavelength in nanometers.
Clear the values of D_min using Reset.

Slowly translate the camera through the lens focal region.
The minimum beamwaist diameters are automatically
entered.

The current values of the beam diameter, D_current, are
shown below D_min.

Wavelength 0.0 nm

Aperture 1 Aperture 2

D min Reset um

D current um

Setup the laser and sensor so that you can easily move the sensor along the
Z-axis (nearer or farther from the laser). Then start the K-Factor wizard.
Follow the instructions that appear. Upon completing each step, select the
Next button to continue. If you make a mistake select the Previous button
and redo that step. When you have completed all of the steps, the wizard will
display the results. It's that easy!

For more information, please read Application Note 230 available from your
Photon Inc. representative or the Photon website, www.photon-inc.com.

The formula is:

2Ax27Z,
="t o

2
T X Dmin

K r MZ=
K
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where:

A wavelength in nm

27, |Z e — Zmn| - Rayleigh range
D,.. Beam diameter in the beam waist
Z. . Distance along Z axis where beam diameter is 1.414xD_,

(distal to test lens or laser)

Distance along Z axis on the other side of the waist where
beam diameter is 1.414 xD . (proximal to test lens or laser)

min

min

4.5.9.1. Measuring the K-Factor
The K-Factor is a propagation constant for a laser source defined in the ISO
standard as

1 2Ax2Z,
" MZ  zxD?

min

K

Physically, M can be thought of as a factor times the diffraction limit. For
example, if one calculates the diffraction limit for a particular lens, the source
with an M =1.2 will produce a spot width 1.2 times the theoretical calculated
value.

The ISO standard requires 10 beam measurements and a curve-fitting
algorithm. A faster method, called the Rayleigh method, provides accurate
result with only 3 measurements.

The Rayleigh Method can easily be derived from the definitions and gives
fast, highly accurate and repeatable K-Factor values. This method requires
you to measure twice the Rayleigh length for a source. A long focal length
lens (high F# >20) should be used. You also need the wavelength and the
minimum observed beam width, D while sweeping through the beam

waist.

min ?

4.5.9.2. Lens Selection and the Expected Rayleigh Length

How does one select a focusing lens? How does one determine the Rayleigh
distance for a source and a lens?

We have found that the distance along the beam axis can be measured to
the nearest 1/2mm if one selects a focused beam size from 80mm to 200mm
(1/e?) beam width.

B051007616-1.07 Photon Inc.
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Example:

Source nearly collimated wavelength 0.7um and approximate exit beam
width is 500um (1/€?).

The divergence for a diffraction limited source (M =K = 1) will be:

_4xa. 0 4x0.7um

0 ; =
7xD 7 x500um

=0.0018rad;

We can select the lens by assuming:

d=fx6@
or, if we want the predicted waist diameter d near the focal plane to be
125um, the required focal length is:
- 125um
~0.0018

Let’'s use a 75mm lens, which is more commonly found in a laboratory. The
expected spot size is:

=69,444 um or 69mm

d=fx0=75000umx0.0018 =135um

The expected Rayleigh length in the region of the waist will be:

2
szxd_
4 2

where, d is the above 135um calculated spot width.

, _ 0.7854x135um’

=20,448 umor 20.4mm
0.7um

2Z =40,896 um or 40.8mm

Thus we have a rough starting point for K-Factor measurements. If the
K-Factor is much less than 1.0, the spot size will be larger than calculated
and the Rayleigh length will be less than calculated. What is important is that
by using the diffraction limited case one has a starting point. We suggest that
one try this method with a small visible HeNe laser which is nearly always
close to K=1 to gain an appreciation for the method before trying an

unknown source. If you get close to one with the HeNe source, you will have
the measurement method understood! If you get K>1.0, recheck alignment

and go through the waist slowly enough to allow the software time to select
the correct minimum waist.

Photon Inc. B051007616-1.07
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4.5.9.3. Alignment

To measure K-Factor, the user should position the sensor in the beam waist.
Setup the laser and the sensor so the sensor can easily move along the
Z-axis. This alignment is extremely important for getting accurate results!

Alignment of the sensor and laser beam without the focusing lens:

Before inserting the lens into the path, align the sensor axial travel motion
parallel to the axis of the laser. We suggest that the non-alignment be no
more than a couple of beam widths. For the example laser above, this would
be +500 microns. The Pointing window can be used to measure the
misalignment over the Rayleigh range.

For the example source (previous section) this means one should see no
more than £500um motion either X or Y as one translates the sensor along
the beam axis through a distance of 2Z (or 41mm for our example).

Note! Move slowly through the waist region so the software can keep up with
the measurement process.

45.9.4. Insertthelens

Once the sensor and source are aligned, insert and center the lens into the
beam path. Now translate the sensor through the 2Z length and again try to
keep the cross translation to less than +1-2 beam widths. For the example
beam, use the calculated 135um as a goal.

Be sure the lens is well centered or you will be measuring the lens aberration
as well as the K-Factor for the source. With a visible source, one can usually
observe a back reflection from both lens surfaces. Place the back-reflected
beams just slightly to the side of the laser exit aperture. Sending the
reflections back into the source may cause laser oscillations due to
interference.

Another centering approach is to use a machined centered removable
aperture stop just before the lens. This could fit into the lens mount during
alignment and be removed before measurements. Direct the beam through
this small aperture (our source example uses a 2mm hole) during alignment.
Be sure to remove the stop once aligned to prevent truncation of the source
and consequently errors in measured K-Factors.

Now you are ready to use the K-Factor Wizard.
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4.5.9.5. Rayleigh Test Fixture Accessory

Photon offers an accessory, a Rayleigh Test Fixture, which consists of a base
plate, a slide that allows manual sensor axial [Z] translation and an LCD
measurement ruler. The base plate is rigidly mounted to an optical table or
rail. The translation distance readout is a Mitutoyo LCD ruler that spans
150mm of travel and gives position values to the nearest 25um. The total
150mm travel allows the Rayleigh range to be such that a beam waist of
approximately 200um can be measured.

The Mitutoyo scale can be zeroed at the first Rayleigh location, translated to
the second to find a single direct read number in mm units to be inserted into
the Wizard software. This accessory’s purpose is to make measurements of
the Rayleigh range very easy and very repeatable. The user provides a
source, a focusing lens and mount.

4.5.9.6. Dual Axis Measurements with Astigmatism

To measure K-Factor when the source is astigmatic, the user will need to
modify the basic procedure slightly. Figure 4.2 shows what this looks like.

®
®
e O L,

®

Aperture 2

Distance in mm

Figure 4.2. Measurement on Astigmatic Source Using the K-Factor Wizard
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Example Using the Rayleigh Test Fixture Accessory:

1. Move the sensor to D Target for Aperture 1. Reset the Mitutoyo
scale. Enter O for Z Position 1 under the Aperture 1 heading.

2. Move the sensor to D Target for Aperture 2. Enter 10 for Z Position 1
under the Aperture 2 heading. Select the Next button.

3. Move slowly through the waist for Aperture 1 and verify the D, is
correct.

4. Move slowly through the waist for Aperture 2 and verify the D, is
correct.

5. Move the sensor to D Target for Aperture 1. Enter 24 for Z Position 2
under the Aperture 1 heading.

6. Move the sensor to D Target for Aperture 2. Enter 30 for Z Position 2
under the Aperture 2 heading. Select the Next button.

4.6. Toolbars

Toolbars are provided to speed access to some of the most commonly used
operations and features of the USBeamPro Acquisition and Analysis
Software. Instead of accessing these features through the pulldown menus,
simply click on the appropriate icon buttons on the toolbars. The operations
and features include: opening windows, turning data collection on and off,
selecting the acquisition mode, turning Autotracking on and off, and
selecting options. In addition, some file handling operations such as opening
and saving files, opening new files and printing can be initiated in this way.
General program features are accessed on the main toolbar, while option
features for the Video window, Profile window, Beam Statistics window,
and Time Statistics window are accessed on window toolbars. The toolbars
and descriptions of their icon buttons and functions are given below.

For user convenience and preference, toolbars can be placed at different
screen locations by dragging and dropping.
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4.6.1. The Main Toolbar
2= &7 8y & & | R

Opens a new file

Opens the Open file dialog

Saves the current file

Opens the Print dialog

Opens specific Help topics (currently inactive)
Turns Autotracking on/off

Turns Global Data Collection on/off

Opens the Calibration dialog (also indicates the
calibration status)

® @

Sets system to Laser Positioning mode

Sets system to Analysis mode

LB v A& L U IO, [

Sets system to Single Shot mode (currently
inactive)

Opens the Profile window

Opens the Video window

Opens the 3D Profile window. Up to 5 2D and
3D windows combined can be opened.

Opens the 2D Contour window

Opens the Beam Statistics window

Photon Inc. B051007616-1.07
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%g Opens the Time Statistics windows. Up to 15
S windows can be opened simultaneously.

FET Opens the Pointing window

[

ﬁ} Opens the K-Factor window

KM

Opens the Notes window.

46.2. The Video Window Toolbar

a| (]

= Set Beam Area drawing tool

Energy ROI: Elliptical region drawing tool
Energy ROI: Circular region drawing tool
Energy ROI: Rectangular region drawing tool

Energy ROI: Square region drawing tool

4.6.3. The Profile Window Toolbar

v = | ALA
b Starts data collection
n Stops data collection

Gaussian Fit overlay on/off

Wiy Turns Normalization on/off
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46.4. The Beam Statistics Window Toolbar

SEEIE

> Starts data collection

n Stops data collection

» Resets table

e Opens Beam Statistics Parameters dialog

4.6.5. The Time Statistics Window Toolbar

» [ x| [ 2|5

’ Starts data collection

n Stops data collection

x Reset table

H Grid overlay on/off

Xe Statistical calculations overlay on/off

wrZ OpensBeam Statistics Parameters dialog
. Opens Time Stat Axes dialog

4.7. Status Bar

The status bar at the bottom of the screen displays the Trigger Mode, cursor
location and the Beam Area information. The first pane displays the trigger
mode: CW, Ext or Pulsed. The second pane displays intensity in counts at
the mouse cursor location (when is pointing over the Live Window), given by
position coordinates in microns, from the upper left corner. The third pane
displays the position coordinates of the upper left corner in the Beam Area
(BA) and the dimensions in microns of the Beam Area. The fourth pane
displays the update rate in frames/second while global data collection is
turned on. The last pane displays information about the calibration status.

IFDI’ Help, press F1 Trigger: CW 954 cnts @ (5755, 30 pm, 1855.90 pm) BA: 0O(L), O(T) 8565(W) > 6854(H) [um] 12,97 upd/s| System uncalibrated I
—
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4.8. ActiveX Automation

USBeamPro Acquisition and Analysis Software provides a Microsoft
Automation interface. As an automation server, USBeamPro Acquisition and
Analysis Software exposes a set of methods and properties. Using ActiveX
compatible programs such as LabVIEW or Microsoft Excel, a user can create
his own Automation controller, which can display and process data from
USBeamPro Acquisition and Analysis Software.

The type library “USBeamPro.tlb” file in the Automation folder where the
software has been installed contains a full description of the ActiveX
interface. You can open and view this file with an OLE/COM viewer program.

The properties and methods that USBeamPro Analysis Software exports are
explained below.

4.8.1. AcquisitionMode
Property Type:

VT _12 - acquisition mode
Remarks:

Gets or sets acquisition mode.

Possible values are defined in the type Ilibrary file by the
SelectionAcquisitrionMode enumeration:

Acquisition Mode Selection Value Comments
SEL_ACQMODE_ANALYSIS 0 Analysis Acquisition Mode
SEL_ACQMODE_LASERPOS 1 Laser Positioning Acquisition

Mode

SEL_ACQMODE_SINGLESHOT 2 Not available
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4.8.2. TriggerMode

Property Type:

VT 12 - trigger mode
Remarks:

Gets or sets trigger mode.

Possible values are defined in the type library file by the
SelectionTriggerMode enumeration:

Trigger Mode Selection Value Comments
SEL_TRIGGER_CW 0 Trigger Mode — CW
SEL_TRIGGER_PULSED 1 Trigger Mode - Pulsed
SEL_TRIGGER_EXT 2 Trigger Mode - External

4.8.3. AcquisitionResolution
Property Type:

VT_12 - acquisition resolution
Remarks:

Gets or sets the acquisition resolution.

Possible values are defined in the type Ilibrary file by the
SelectionAcquisitionResolution enumeration:

Acquisition Resolution Selection | Value Comments
SEL_RESOLUTION_1X 1 Acquisition Resolution — 1 x
SEL_RESOLUTION_2X 2 Acquisition Resolution — V2 x

4.8.4. GlobalDataCollection

Property Type:

VT_BOOL - global data collection

Remarks:

Enables or disables data collection and queries the value of the flag.

4.8.5. AutoTracking

Property Type:

VT _BOOL - auto track

Remarks:

Enables or disables the auto track feature and queries the value of the flag.

Photon Inc. B051007616-1.07




4.62 USBeamPro Installation and Operation Manual

4.8.6. MagnificationFactor
Property Type:

VT_R4 — magnification factor
Remarks:

Gets or sets the external optics magnification factor. The range for the
magnification factor value is between 0.01 and 1000.

4.8.7. AngleUnits

Property Type:
VT _12 — angle units
Remarks:

Gets or sets the units used for reporting all the angles. Possible values are
defined in the type library file by the SelectionAngleUnits enumeration:

Angle Units Selection Value Comments

SEL_ANGLE_UNITS_MRAD 0 Reports all the angles in miliradians

SEL_ANGLE_UNITS _DEG 1 Reports all the angles in degrees

4.8.8. I1SOWidthMethod

Property Type:

VT _12 - method for computing beam width

Remarks:

Gets or sets the method used for computing beam widths.

If the 4Sigma method is selected, only the 1/e? clip level beam width is
computed.

Possible values are defined in the type library file by the SelectionlSOWidth
enumeration:

ISO Width Method Selection | Value Comments

SEL ISO D SLIT ’ Slit mgthod used for computing
- T~ beam widths.

SEL ISO D ENERGY 2 Encircled energy method used for
- T~ computing beam widths.

SEL_ISO_D_4SIGMA 3 Second moment method (4Sigma)

used for computing beam widths.
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4.8.9. UseCliplevel

Method Return Value:

VT_EMPTY - none

Method Parameter List:

VTS _R4 - cliplevel in percentage

VTS _BOOL - use

Remarks:

Enables beam width computation at the specified clip level.

If the selected ISO method for computing the beam width is Energy, the
beam energy should be used instead of the clip level.

To enable beam width computation at a specified clip level, set the use flag to
TRUE. To disable beam width computation at a specified clip level, set the
use flag to FALSE.

Without this function call, the beam width numbers returned from
USBeamPro may not be valid. This function has to be called only once, at
the beginning of the program, before any call to GetPeakWidth, GetEllipticity,
GetEccentricity or GetPeakDivergence.

4.8.10. GetWidth

Method Return Value:

VT_R4 - beam width

Method Parameter List:

VTS |2 - axis

VTS_R4 - cliplevel

Remarks:

Returns the beam width in microns.

If the selected ISO method for computing the beam width is Energy, the
beam energy should be used instead of the clip level.

Possible values for the axis are 0 and 1. If elliptical analysis has been
enabled (see EllipticAnalysis), 0 represents the major axis and 1 the minor
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where
horizontal and vertical are relative to the camera.

If the selected ISO method for computing the beam width is Energy, then
only one beam width number is computed. In this case, the beam width
values for axis 0 and axis 1 are equal.

If the selected ISO method for computing the beam width is 4Sigma, then
only the beam width is computed. The specified “clip level” must be 1/e?.

To enable beam width computations for the specified clip level, UseCliplevel
has to be called before the first call to GetPeakWidth,
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4.8.11. GetPeakPosition

Method Return Value:

VT_R4 - peak position

Method Parameter List:

VTS_I2 - axis

Remarks:

Returns the peak position in microns.

Possible values for the axis are 0 and 1. If elliptical analysis has been
enabled (see EllipticAnalysis), O represents the major axis and 1 the minor
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where
horizontal and vertical are relative to the camera.

4.8.12. GetCenter

Method Return Value:

VT_R4 - centroid position

Method Parameter List:

VTS_I2 - axis

Remarks:

Returns the centroid position in microns.

Possible values for the axis are 0 and 1. If elliptical analysis has been
enabled (see EllipticAnalysis), O represents the major axis and 1 the minor
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where
horizontal and vertical are relative to the camera.

4.8.13. GetPeaklrradiance

Method Return Value:

VT_I2 - peak irradiance

Method Parameter List:

VTS_NONE - none

Remarks:

Returns the irradiance of the peak. Possible values are 0...1023.

4.8.14. EllipticAnalysis
Property Type:

VT_BOOL - elliptic analysis

Remarks:

Gets or sets the elliptical analysis flag.

If this flag is TRUE, the elliptical analysis is enabled and GetRotationAngle,
GetEllipticity and GetEccentricity will return valid numbers.
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4.8.15. GetRotationAngle

Method Return Value:

VT_R4 - rotation angle

Method Parameter List:

VTS_NONE - none

Remarks:

Returns the orientation of the computed major axis in degrees.

This function returns valid numbers only if elliptical analysis has been
enabled, using EllipticAnalysis.

4.8.16. GetEllipticity

Method Return Value:

VT_R4 - ellipticity

Method Parameter List:
VTS_R4 - cliplevel

Remarks:

Returns the ellipticity of the beam.

If the selected ISO method for computing the beam width is Energy, the
beam energy should be used instead of the clip level. In this case, the
ellipticity will be 1, because there is only one beam width value.

This function returns valid numbers only if elliptical analysis has been
enabled, using EllipticAnalysis. Also the beam width computation for the
specified clip level should have been enabled, using UseCliplevel, because
the beam width numbers are used in the computation of the ellipticity.

4.8.17. GetEccentricity

Method Return Value:

VT_R4 - eccentricity

Method Parameter List:

VTS R4 - cliplevel

Remarks:

Returns the eccentricity of the beam.

If the selected ISO method for computing the beam width is Energy, the
beam energy should be used instead of the clip level. In this case, the
eccentricity will be 0, because there is only one beam width value.

This function returns valid numbers only if elliptical analysis has been
enabled, using EllipticAnalysis. Also the beam width computation for the
specified clip level should have been enabled, using UseCliplevel, because
the beam width numbers are used in the computation of the eccentricity.

Photon Inc. B051007616-1.07



4.66 USBeamPro Installation and Operation Manual

4.8.18. FlatTopAnalysis
Property Type:

VT_BOOL - flat top analysis
Remarks:

Gets or sets the flat top analysis flag.

Flat top numbers will be computed over a Region of Interest that can be
user-defined.

If this flag is TRUE, the flat top analysis is enabled and GetFlatTopMin,
GetFlatTopMax, GetFlatTopMean, GetFlatTopFlatness, GetFlatTopUniformity
and GetFlatTopEnergy will return valid numbers.

4.8.19. FlatTopThreshold
Property Type:

VT_R4 - flat top threshold
Remarks:

Gets or sets the threshold value (percentage of the peak pixel value) used for
flat top analysis.

The allowed range of the threshold is between 0 and 100.

4.8.20. GetFlatTopMin

Method Return Value:

VT _I2 - flat top minimum

Method Parameter List:

VTS _NONE - none

Remarks:

Returns the minimum pixel value in the defined Region of Interest.

This function returns valid numbers only if flat top analysis has been enabled,
using FlatTopAnalysis.

4.8.21. GetFlatTopMax

Method Return Value:

VT_I2 - flat top maximum

Method Parameter List:

VTS_NONE - none

Remarks:

Returns the maximum pixel value in the defined Region of Interest.

This function returns valid numbers only if flat top analysis has been enabled,
using FlatTopAnalysis.
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4.8.22. GetFlatTopMean

Method Return Value:

VT_R4 - flat top mean

Method Parameter List:

VTS_NONE - none

Remarks:

Returns the mean value of all pixels in the defined Region of Interest.

This function returns valid numbers only if flat top analysis has been enabled,
using FlatTopAnalysis.

4.8.23. GetFlatTopFlatness

Method Return Value:
VT_R4 - flat top flatness
Method Parameter List:
VTS_NONE - none
Remarks:

Returns the beam flatness in the defined Region of Interest. Flatness is
defined as the ratio of the average to the maximum power density. The range
is 0 -1 with 1 being a perfectly flat beam.

This function returns valid numbers only if flat top analysis has been enabled,
using FlatTopAnalysis.

4.8.24. GetFlatTopUniformity

Method Return Value:
VT _R4 - flat top uniformity
Method Parameter List:
VTS _NONE - none
Remarks:

Returns the beam uniformity in the defined Region of Interest. Uniformity is
defined as the normalized RMS deviation of power energy density from its
average. A value of 1 indicates a completely uniform distribution having a
profile with a flat top and vertical edges.

This function returns valid numbers only if flat top analysis has been enabled,
using FlatTopAnalysis.
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4.8.25. GetFlatTopEnergy

Method Return Value:

VT_R4 - flat top energy

Method Parameter List:

VTS_NONE - none

Remarks:

Returns the total sum of the pixels inside of the defined Region of Interest.

This function returns valid numbers only if flat top analysis has been enabled,
using FlatTopAnalysis.

4.8.26. GaussianFitAnalysis
Property Type:

VT_BOOL - Gaussian analysis
Remarks:

Gets or sets the Gaussian analysis flag.

If this flag is TRUE, the 1-dimensional Gaussian analysis is enabled and
Gaussian fit numbers can be computed using Get1dGaussianFit.

4.8.27. GetldGaussianFit

Method Return Value:
VT_R4 - Gaussian fit

Method Parameter List:
VTS_I2 - axis

Remarks:

Returns Gaussian fit numbers.

This function returns valid numbers only if Gaussian analysis has been
enabled, using GaussianFitAnalysis.

Gaussian fit numbers are computed for the profiles that represent a pinhole
scan through the data. In USBeamPro these profiles and their correspondent
Gaussian fitted profiles can be visualized in the Profile view.

Usually the pinhole data is obtained from a scan through the beam centroid.

Possible values for the axis are 0 and 1. If elliptical analysis has been
enabled (see EllipticAnalysis), 0 represents the major axis and 1 the minor
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where
horizontal and vertical are relative to the camera.

If the user has moved the position of the cross hairs in the LiveVideo (either
to peak, or to a user-defined point), the pinhole scan will go through the
newly defined intersection of the two axes. The user can also change the
rotation of the major and minor axes.

B051007616-1.07 Photon Inc.



Chapter 4. Acquisition and Analysis Software

4.69

4.8.28. BackgroundCorrection

Property Type:

VT_I2 - background correction method

Remarks:

Gets or sets the method used for subtracting the camera background.

Possible values are defined in the type library file by
SelectionBackgroundSubtraction enumeration:

the

Acquisition Resolution Selection | Value Comments
SEL_BKGND_NONE -1 No background subtraction
SEL_BKGND_FRAME 0 Frame subtraction
SEL_BKGND_MEAN 1 Mean subtraction

4.8.29. SetDivergenceMethod

Method Return Value:
VT_EMPTY - none

Method Parameter List:
VTS_I2 - divergence method
VTS R4 - distance

VTS_RA4 - cliplevel
Remarks:

Sets the divergence method and associated parameters used for the

divergence calculation.

If the selected ISO method for computing the beam width is Energy, the

beam energy should be used instead of the clip level.

Possible values for divergence method are defined in the type library file by

the SelectionDivergenceMethod enumeration:

Divergence Method Selection | Value Comments
SEL_DIV_METHOD_OFF 0 No divergence computations.
SEL DIV METHOD LENS 1 Lgns method for computing

- - divergence.
SEL_DIV_METHOD_PTSRC o | Point  Source method for

- - computing divergence.
SEL_DIV_METHOD_NA 3 Numerical Aperture method for

computing divergence.
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The distance parameter represents the Focal Length if the Lens method has
been selected, or the Distance from the Point Source if the method is Point
Source or Numerical Aperture.

4.8.30. GetDivergenceMethod

Method Return Value:
VT_EMPTY - none

Method Parameter List:
VTS_PI2 - divergence method
VTS _PRA4 - distance
VTS_PR4 - cliplevel
Remarks:

Gets the divergence method and associated parameters used for the
divergence calculation.

4.8.31. GetDivergence

Method Return Value:
VT_R4 - divergence
Method Parameter List:
VTS |2 - axis

Remarks:

Returns the divergence.

Before measuring divergence, the divergence parameters should have been
set using SetDivergenceMethod and the beam width computation should
have been enabled for the specified clip level using UseCliplevel.

The divergence is returned in mrad if the selected divergence method is
Lens, degrees if the selected divergence method is PointSource and is
unitless if the selected divergence method is NumericAperture.

Possible values for the axis are 0 and 1. If elliptical analysis has been
enabled (see EllipticAnalysis), O represents the major axis and 1 the minor
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where
horizontal and vertical are relative to the camera.
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4.8.32. GetProfileData

Method Return Value:
VT_VARIANT - profile data array
Method Parameter List:
VTS_I2 - axis

VTS 14 - start index

VTS _I4 - number of points
Remarks:

Returns an array of data points that represents a pinhole scan through the
beam area.
Usually the pinhole data is obtained from a scan through the beam centroid.

Possible values for the axis are 0 and 1. If elliptical analysis has been
enabled (see EllipticAnalysis), O represents the major axis and 1 the minor
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where
horizontal and vertical are relative to the camera.

If the user has moved the position of the cross hairs in the LiveVideo (either
to peak, or to a user-defined point), the pinhole scan will go through the
newly defined intersection of the two axes. The user can also change the
rotation of the axes.

Start index represents the index in the pinhole scan data array that will
correspond to the first data point returned.

Number of points represents how many points will be copied in the returned
array.

4.8.33. GetProfileSampleSize

Method Return Value:
VT_R4 - sample size
Method Parameter List:
VTS _I2 - axis

Remarks:

Returns the sample size: the distance between two data points of the profile
data array, in microns.

Possible values for the axis are 0 and 1. If elliptical analysis has been
enabled (see EllipticAnalysis), O represents the major axis and 1 the minor
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where
horizontal and vertical are relative to the camera.
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4.8.34. GetProfileNumPts

Method Return Value:
VT _12 - number of points
Method Parameter List:
VTS_I2 - axis

Remarks:

Returns the number of points in the profile data array, which is bound, by the
beam area.

Possible values for the axis are 0 and 1. If elliptical analysis has been
enabled (see EllipticAnalysis), 0 represents the major axis and 1 the minor
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where
horizontal and vertical are relative to the camera.

4.8.35. GetSampleSize

Method Return Value:

VT_R4 - sample size

Method Parameter List:

VTS _NONE - none

Remarks:

Returns the dimension of one pixel from the data array, in microns.

4.8.36. GetNumPts

Method Return Value:

VT _14 - number of points

Method Parameter List:

VTS _I2 - axis

Remarks:

Returns the number of points inside the beam area.

Possible values for the axis are 0 and 1. If elliptical analysis has been
enabled (see EllipticAnalysis), 0 represents the major axis and 1 the minor
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where
horizontal and vertical are relative to the camera.
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4.8.37. GetTotalSize

Method Return Value:

VT _I4 - total size

Method Parameter List:

VTS_I2 - axis

Remarks:

Returns the dimension of the beam area, in microns.

Possible values for the axis are 0 and 1. If elliptical analysis has been
enabled (see EllipticAnalysis), O represents the major axis and 1 the minor
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where
horizontal and vertical are relative to the camera.

4.8.38. GetStartPos

Method Return Value:
VT_I4 - start position
Method Parameter List:
VTS_I2 - axis

Remarks:

Returns the distance from the edge of the camera chip to the beam area in
microns.

Possible values for the axis are 0 and 1. If elliptical analysis has been
enabled (see EllipticAnalysis), O represents the major axis and 1 the minor
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where
horizontal and vertical are relative to the camera.

4.8.39. ImageRotation
Property Type:

VT _12 — image rotation
Remarks:

Gets or sets the clockwise rotation of the image from the original frame.
Possible values are 0, 90, 180 or 270.
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4.8.40. ImageFlip
Property Type:

VT _12 - image flip
Remarks:

Gets or sets the orientation of the image with respect to Vertical and
Horizontal. Possible values are defined in the type library file by the
ImageFlipSelection enumeration:

Image Flip Selection | Value Comments
SEL_FLIP_NONE 0 Display the original frame
SEL_FLIP_HORIZ 1 Flip the image about the horizontal axis
SEL_FLIP_VERT 2 Flip the image about the vertical axis

4.8.41. DoCalibration

Method Return Value:

VT_EMPTY - none

Method Parameter List:

VTS _NONE - none

Remarks:

Performs a calibration routine for the camera.

4.8.42. IsCalibrated

Method Return Value:

VT _BOOL - calibration status

Method Parameter List:

VTS _PDATE - date when the system calibration occurred
Remarks:

This method returns the calibration status of the system.
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4.8.43. SetBeamArea

Method Return Value:

VT_BOOL - if Beam Area has been modified successfully
Method Parameter List:

VTS R4 - left

VTS _R4 - top

VTS R4 - right

VTS R4 - bottom

Remarks:

Sets a manual Beam Area. Turn AutoTrack off before you use this function,
otherwise the Beam Area may change automatically while the software is
trying to track the beam. The parameter list values are the coordinates of the
Beam Area rectangle in microns, from the upper left corner of the array
(which is (0,0)). If the Beam Area cannot be set (the coordinates are not
within the array range), the return value is FALSE. If the Beam Area has
been modified successfully, the return value is TRUE.

4.8.44. GetBeamArea

Method Return Value:

VT_BOOL - Beam Area status

Method Parameter List:

VTS_PR4 - left

VTS PR4 - right

VTS _PRA4 - top

VTS_PR4 - bottom

Remarks:

Gets the Beam Area coordinates. The parameter list values are the
coordinates of the Beam Area rectangle in um, from the upper left corner of

the array (which is (0, 0) ). If there is no Beam Area the return value is
FALSE. If there is a valid Beam Area the return value is TRUE.

4.8.45. ComputationsDone

Property Type:
VT_BOOL — computations flag
Remarks:

Gets or sets the status of the frame computation. If this flag is TRUE that
means that at least one frame was acquired and processed. Set this flag to
FALSE before initiate a data acquisition and then wait until the state is TRUE
in order to be sure a new frame was acquired and processed.
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4.8.46. Recompute

Method Return Value:
VT_EMPTY - none
Method Parameter List:
VTS_NONE - none
Remarks:

Redo computations for selected parameters based on the current settings.
Computations are done on the image data that is currently in memory.

4.8.47. GetTotalEnergy

Method Return Value:

VT_R4 - total energy

Method Parameter List:

VTS _NONE - none

Remarks:

Returns total sum of the pixels inside of the defined Beam Area.

4.8.48. IsSaturated

Method Return Value:

VT_BOOL - saturation flag

Method Parameter List:

VTS _NONE - none

Remarks:

Returns TRUE if signal is saturated, FALSE otherwise.

4.8.49. ShowWindow

Property Type:
VT_BOOL - Show flag
Remarks:

Shows or hides the USBeamPro Analysis Software main window. Call this
function with FALSE as parameter to hide the USBeamPro Analysis
Software. Call this function with TRUE if you want to show the USBeamPro
Analysis Software.
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4.8.50. ProfileType
Property TYpe

VT _I2 - profile type
Remarks:

Gets or sets the profile types, either Pinhole or equivalent Slit. The value set
with this function will impact the arrays obtained by GetProfileData method.
Possible values are defined in the type library file by the ProfileTypeSelection
enumeration:

Profile Type Selection Value Comments
SEL_PROFILE_PINHOLE | 0x00 | Pinhole profiles through the crosshairs.
SEL_PROFILE_SLIT 0x01 | Equivalent slit profiles.

4.851. Get2DData

Method Return Value:

VT _VARIANT - 2D data array
Method Parameter List:
VTS _R4 - left

VTS R4 - top

VTS R4 - right

VTS _R4 - bottom

VTS _I2 - decimation
Remarks:

Returns a 2D-array (matrix) of data points representing the 2D intensity data
(values between 0 and 1023). The first four values from the parameter list
are the coordinates of the rectangle area from where the data is exported, in
um, the coordinates are reported from the upper left corner of the array
(which is (0, 0)). The decimation value can be used to read out a smaller
array of data and it is used in both lines and columns of the matrix (transfer
every n™ pixel on every n" line, where n is the decimation value).
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4.8.52. CameraExposure
Property Type

VT_R4 — camera exposure
Remarks:

Gets or sets the exposure time for the camera, in ms. The range for the
exposure value is from 0.03 to 30.

4.8.53. Averaging
Property Type

VT _|2 — average value
Remarks:

Gets or sets the number of frames used in averaging. The range for the
average value is between 1 and 1000.

4.8.54. ProfileCrossHairsType
Property Type

VT _12 — profile cross hairs

Remarks:

Gets or sets profile cross hairs type. If the Profile Type is set to Slit
(Equivalent Slit Profiles) the only option available is Centroid.

Possible values are defined in the type Ilibrary file by the
SelectionProfileCrossHairsType enumeration:

Profile Cross Hairs Selection Value Comments
SEL_XHAIR_CENTROID 0 Cross hairs through the centroid
SEL_XHAIR_PEAK 1 Cross hairs through the peak

Cross hairs through a wuser

SEL_XHAIR_USERDEF 2 . "
— - defined position
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4.8.55. SetProfileCrossHairsPos

Method Return Value:

VT_BOOL - if position for profile Cross Hairs has been modified successfully
Method Parameter List:

VTS _R4 - posHoriz

VTS _R4 - posVert

Remarks:

Sets the position (horizontal and vertical) for the user defined crosshairs, in
microns. This method can be called only if the Profile Type is set to Slit
(Equivalent Slit Profiles).

4.8.56. GetProfileCrossHairsPos

Method Return Value:

VT_BOOL - if position for profile Cross Hairs has been retrieved successfully
Method Parameter List:

VTS _PR4 - posHoriz

VTS PR4 - posVert

Remarks:

Retrieves the position (horizontal and vertical) for the crosshairs, in microns.

4.857. SaveFrameAsTIFF

Method Return Value:

VT _BOOL - Save Flag status

Method Parameter List:

VTS _BSTR - file full name (with qualified path if necessary)
Remarks:

Saves the current frame (raw image) as an uncompressed 16-bit TIFF file. If
the operation was successful, the method returns TRUE, otherwise returns
FALSE.
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4.8.58. GetCameralList

Method Return Value:

VT_VARIANT — array of strings; each string uniquely corresponds to a
camera present on the system

Method Parameter List:

VTS_NONE - none

Remarks:

Call this property to retrieve the number of cameras present on the system,
and for each camera the uniquely associated corresponding string. The first
element in the array always corresponds to the camera that is currently used

by the USBeamPro software. These strings need to be passed as parameter
to SelectCamera method in order to select a specific camera.

4.8.59. SelectCamera

Method Return Value:

VT_BOOL - Camera selection status

Method Parameter List:

VTS _BSTR — Camera identifier

Remarks:

Selects a different camera for use with the USBeamPro software. To select a

camera pass the uniquely associated string with the camera that was listed in
the GetCameraList method.

If the operation was successful, the method returns TRUE, otherwise returns
FALSE.

After a new camera was selected the system is not calibrated and the global
data collection is turned off.

4.8.60. Example files

In the Automation folder under the folder where the software has been
installed (the default settings is “C:\Program Files\Photon\USBeamPro”)
there are two detailed examples about using ActiveX: one written in Visual
Basic for Application (VBA) using Microsoft Excel “USBeamPro ActiveX
Example.xls” and one developed in LabVIEW “USBeamPro ActiveX
Example.vi”.

B051007616-1.07 Photon Inc.



=« FREQUENTLY ASKED
QUESTIONS

Q1. The following questions all pertain to the
measurement of energy or power in your laser beam.
Please refer to the answer below:

¢

*® & o o

® & 6 O O o o

How do | measure energy/power in my beam?

How do | measure the energy/power in a section of my beam?
What does "ROI" mean?

How do | set the region of interest?

How do | change the energy units from CNT to something
meaningful?

How do | measure fluence?

How do | measure peak intensity in meaningful units?

What does Uniformity mean? How is it calculated?

What does Flatness mean? How is it calculated?

How do | measure power density?

How can | measure the energy contained in a satellite beam?
How can | measure the energy in two equal sized areas within
my beam?

How can | move the selected region of interest without
changing it's size?

Energy/Power measurements can be made on any area or region of your
laser beam, (Energy measurements are made on pulsed beams, whereas
Power measurements are made on CW beams.)

To perform this measurement, select "Flat Top Analysis" in the Data
Analysis dialog box accessed from the Data Collection Menu.

The units of the energy/power analysis are also selected under the Data
analysis dialog. Units available are: mW, mW, W, for CW beams or mJ, mJ, J,

Photon Inc.
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for pulsed beams. When selected, the Energy/Power parameter values will
be displayed in the appropriate MKS units.

1. Define an area, called the Energy Region of Interest (Energy
ROI), using the drawing tools in the Video window. The
drawing tools can be accessed either through the Options
menu or by using the four yellow icons on the Video window
toolbar. If using the menus, select "Overlays" from the Options
menu. Another menu will appear. Then, select "Energy ROI" to
obtain the final menu where you must select one of the four
area types: Circular, Elliptical, Square, Rectangular. If using
the icons, simply click on the icon of the desired area type.
(Note: If icons are “grayed out”, Flat Top Analysis is not on.)

2. Draw a ROI. Using the mouse, position the cursor at one
"corner” of your desired area, hold down the left mouse button
and drag the mouse to the opposite "corner"”. (For circular and
elliptical areas, the "corners" are the points at which tangents
of the area perimeter, aligned along the principal axes,
intersect.) As you draw, you will see a "fat" outline of the area
selected. Release the mouse to "freeze" the outline. The ROI
can be drawn only inside the Beam Area!

3. If the area is not exactly what you want, you can now use the
mouse to change the selected area, or you can draw a new
area as in Step #3 above.

4. Once you are satisfied with the selected area, you must
perform steps to validate your selection. You can validate your
selection in 2 ways:

a. From the Options menu, select "Energy ROI" and click on the
area type that was drawn. Or,

b. From the toolbar, click on the Area icon for the area you -
selected. The energy ROI has now been defined. All Flat Top
Analysis will be performed only in this portion of the Video
Image.

5.  You can move the ROI to different locations, and then use the
Recompute feature to analyze the energy in the new locations.
If you want to use the exact same area used previously,
simply select the "drawing" tool, then while pressing the CTRL
key on your keyboard, use the mouse to drag the ROI to the
new location.

Displaying the Energy ROI in the Video window:
This feature is optional. An overlay of the selected Energy ROI
can be displayed on the Video Screen if the user desires; or,
the overlay can be left invisible. This option is available under
Options, Overlays, Energy ROI.
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6. Definitions of Uniformity and Flatness
The beam Uniformity is defined in the ISO Standard as:

NG| (B - Euel axay

Uniformity = U = 1
Epve

The beam Flatness Factor is defined in the ISO Standard as:

Average

Flatness Factor = F = -
Maximum

;O0<F<1

Q2. How do | automatically follow a moving beam?

To automatically "follow" a moving beam, use the Auto Track feature. This
feature is available either under the Data Collection Menu or by clicking the
Auto Track icon on the main toolbar. When selected, the software
determines an area, called the "Beam Area", in which profile calculations will
be performed.

Qs. How do | measure the "short and long" beam
diameter and determine the beam rotation in an
elliptic beam?

To determine the "long" and "short" diameters of your beam, and the rotation
of your beam, select "Elliptical Analysis" in the Data Analysis dialog box.
When "Elliptical Analysis" is enabled, beam calculations will be performed to
determine the major and minor axes, the beam ellipticity (the ratio of the
1/e2 (13.5%) widths of the major and minor axes) and the tilt angle (angle
with respect to horizontal) of the major axis. The elliptical parameters can be
displayed in the Beam Statistics Parameters dialog.

Q4. How do | subtract the background noise?

To subtract background noise, you must first perform a calibration to
generate a background calibration factor. This is done through the
Calibration dialog box accessed under the Data Collection menu. Also, the
system must be operating in the Analysis mode. A new calibration file is
generated whenever you perform a calibration.

Two types of background subtractions are available; either "frame" or
"mean”. The selection is available under the Data Collection menu by
selecting "Background Subtraction”. The choice is available because some
cameras have very non-uniform backgrounds and some ambient
background conditions are also non-uniform. In cases like these, "Frame
Subtraction” is recommended. You may also want to use "Frame
Subtraction” for very small beams. The choice is yours.
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The background in the calibration file is automatically subtracted from your
data. It is important to perform calibrations periodically to ensure that the
stored background file is appropriate for your present condition. The
background can change significantly due to changes in attenuation and
room lighting, or for such things as subtle as the brightness of the shirt you
wear.

Q5. How do | measure my pulsed beam?

There are two ways to measure pulsed beams. The best way is to use the
External Trigger Mode, available under the Data Collection menu by
selecting Trigger Mode. You must supply an external TTL level signal to the
external input trigger BNC connector on the Image Capture Card. A trigger
cable is available from Photon, inc. as Option /TRG or you can make one
yourself.

If you cannot provide an external trigger, use the Pulsed Trigger mode, also
available under the Data Collection, Trigger Mode sub-menu. When this
mode is selected, the software will automatically determine the presence of
the beam based on a minimum signal amplitude of 32 counts out of 1024,
i.e., 3.125% full scale. In this mode, the update rate will, in general, be
reduced. Do not select External Trigger if one is not present.

Q6. How do | draw/measure a Gaussian fit?

A Gaussian fit can be calculated by selecting "Gaussian 1D" in the Data
Analysis dialog box. The fit is calculated according to the ISO Standard.
Once the fit calculation is enabled, an overlay can be drawn over the beam
profiles in the Profile window. This is accomplished either through the Profile
window option menu or by clicking on the "Gaussian Fit Overlay" #* icon on
the Profile window toolbar. The Gaussian Fit Parameter can be reported in
the Beam Statistics window.

Q7. How do | measure peak intensity?

To measure peak intensity, open the Beam Statistics Parameter dialog box,
available under the options menu for the Beam Statistics window option
menu, or by clicking the "Parameter” = icon on the Beam Statistics window
toolbar. Select "Peak" to display the peak intensity (in counts) in the Beam
Statistic Parameter dialog.

Q8. How do | set or display beam area?

The Beam Area is set in one of two ways. The simplest way is to click on the
beam area drawing tool icon on the Video window toolbar. Then use the
mouse to draw a rectangular region in the Video window. (Note that the
software must first be operating in the Analysis mode). To draw, place the
mouse at one corner of your desired area; then hold down the left mouse
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button and drag the mouse to the opposite "corner”. As you draw, you will
see a "fat" outline of the area selected. Then, to set the area, click the beam
area icon again. The Beam Area outline will now appear as a thin line. The
second method is to select the Beam Area drawing tool from the Options
menu of the Video window.

Displaying the beam area is optional. To display the beam area, select
"Beam Area" from the Overlays sub-menu in the Options menu.

Q9. How do | know the size of the beam area?

The size of the Beam Area used for all computation is displayed on the
Status Bar at the lower right corner of the screen. The upper left coordinate
and size of the rectangle are shown in microns.

Q10. How do | monitor my laser over long periods?

There are two ways to monitor your laser over long periods of time. This is
done using either the Beam Statistics window or the Time Statistics window.
(You can open up to 15 Time Statistic windows) You can select the windows
under the windows menu or by clicking the icon on the main toolbar. You
must define the parameter that you wish to display. This can be done in the
Parameter dialog box, accessed either from the Options menu or by clicking
on the ¥ icon on the local toolbar.

Q1l1. How do | add my notes to the data that | just
collected?

Notes can be appended to your data by using the Notes window. The Notes
window can be opened either through the windows menu or by clicking on
the Notes window icon from the main toolbar. Use the Notes window like
any text editor.

Q12. How can | print the data | collected?

There are several ways to print hard copies of your data. You can either use
the Print feature under the File menu or you can save your screen as an
image file (either bitmap, JPEG, Tiff, Giff or PNG file) and copy it to another
program and print.

Q13. What options do | have for saving and outputting
data?

There are many ways to save your data. You can save screens with data,
save screens as an image file, raw pixel data files, or you can log data to
files. The save options are available from the "Save" or "Save As" selection
under the file menu. The data logger options are accessed from the Beam
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Statistics Parameter dialog box under the Options menu of the Beam
Statistics window.

Ql1l4. What statistics can be calculated?

Statistical quantities available are the Mean, Min, Max and Standard
Deviation. These selections are made through the Beam Statistics
Parameters dialog box available under the Options Menu of the Beam
Statistics window.

Q15. How do I profile through a different cross section?

You can profile through a different cross section by moving the Cross Hairs
in the Video window (the profiles are displayed in the Dual Aperture Profile
window). This is done with the mouse by grabbing the cross hair (click on
the left mouse button) and dragging to a new location.

Q16. How do | profile through a different cross hair
rotation?

To change the rotation of the cross hair, the system must be operating in the
Elliptical Analysis mode available from the Data Analysis dialog box under
the Data Collection menu. Grab one of the axes by left clicking on the
mouse, and while simultaneously holding down the "Ctrl" key, use the
mouse to drag the cross hair to a different rotation.

Q1l7. Why can't | see the cross hairs?

If the cross hairs are not visible in the Video window, then the cross hair
display feature has been turned off. They can be displayed from the Options
menu under the Overlays sub-menu by selecting "Cross Hairs".

Q18. How do | remove the cross hairs?

To turn off the cross hair display in the Video window, go to the Options
menu under the Overlays sub-menu and "deselect” the "Cross Hairs" option.

Q19. How can | change the clip levels?

If in the Data Analysis dialog box, under the Data Collection menu, the
analysis method for ISO profiles is set to “D slit”, clip levels of 13.5%, 36.8%,
50%, 60.7% and one user level are available under the Beam Statistics
Parameter and/or Time Statistics Parameter dialog boxes, available by
selecting the clip level of choice under "Beam Width". If you selected "User
%", then you must also enter the clip level value.

If in the Data Analysis dialog box, under the Data Collection menu, the
analysis method for ISO profiles is set to “D energy”, clip levels of 86.5%,
63.2%, 50%, 39.3% and one user level are available under the Beam
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Statistics Parameter and/or Time Statistics Parameter dialog boxes,
available by selecting the clip level of choice under "Beam Width". If you
selected "User %", then you must also enter the clip level value.

If in the Data Analysis dialog box, under the Data Collection menu, the
analysis method for ISO profiles is set to D 4sigma, there is no selection for
clip levels.

Q20. How do | customize the screen?

You can customize the screen in the usual Windows feature by sizing and -
arranging windows or by using the Cascade and Tile Feature available
under the Windows menu.

Q21. How do | zoom in on the beam?

You can "Zoom In" on the beam displayed in the Video window by selecting
"Zoom" under the Options Menu. Choices available are: 1:2x 1x, 2x, 4x, 8x,
16x and Fit to window (proportional to the camera array dimension).

Q22. How do | customize the color scheme?

The color scheme of 2D and 3D displays can be customized under the Clip
Level dialog box available under the options menu for each applicable
window.

The color scheme of Video can be customized under the Select colors item
from the Options menu.

Q23. How do I normalize the graphs?

The profiles displayed in the Profile window can be normalized (expand the
display to show a peak value of 100%) either from the options menu or by
clicking on the Normalize Icon on the local toolbar. If the Profile mode is set
to Slit, the profiles are always normalized.

Q24. How can the toolbar buttons save me time?

The toolbar buttons save you time by affording you immediate access to
selected features. They eliminate the time required to access these features
through the various menus and sub-menus.
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